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The information in this guide is subject to change without notice. BD reserves the right to change its products
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assumes no liability for any errors or omissions, nor for any damages resulting from the application or use of
this information. BD welcomes customer input on corrections and suggestions for improvement.
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For US patents that may apply, see bd.com/patents.
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diagnostic use. Any other use requires a commercial sublicense from GE Healthcare, 800 Centennial Avenue,
Piscataway, NJ 08855-1327, USA.

Laser safety information
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FCC information
WARNING: Changes or modifications to this unit not expressly approved by the party responsible for
compliance could void the user’s authority to operate the equipment.

NOTICE: This equipment has been tested and found to comply with the limits for a Class A digital device,
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against
harmful interference when the equipment is operated in a commercial environment. This equipment generates,
uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction
manual, may cause harmful interference to radio communications. Operation of this equipment in a residential
area is likely to cause harmful interference in which case the user will be required to correct the interference at
his or her own expense. Shielded cables must be used with this unit to ensure compliance with the Class A FCC
limits. This Class A digital apparatus meets all requirements of the Canadian Interference-Causing Equipment
Regulations. Cet appareil numérique de la classe A respecte toutes les exigences du Réglement sur le matériel
brouilleur du Canada.
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1
1

About this guide
This chapter covers the following topics:
l What this guide covers (page 10)
l Conventions (page 10)
l About the BD FACSymphony™ A1 documentation (page 10)
l Instrument technical support (page 11)
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What this guide covers
This guide describes the procedures necessary to operate and maintain your BD FACSymphony™ A1 flow
cytometer. Because many cytometer functions are controlled by BD FACSDiva™ software, this guide also
contains information about software features required for basic cytometer setup and operation.

This guide assumes you have a working knowledge of basic Microsoft®Windows® operation. If you are not
familiar with the Windows operating system, see the documentation provided with your computer.

Conventions

Introduction
The following table lists the safety symbols used in this guide to alert you to potential hazards.

Safety symbols

Symbol Meaning

Caution! Identifies a hazard or unsafe practice that could result in data loss, material damage, minor injury,
severe injury, or death

Biological hazard

Electrical hazard

Laser hazard

About the BD FACSymphony™ A1 documentation

Introduction
This topic describes the documentation available with the BD FACSymphony™ A1 flow cytometer.

Documentation USB Card
This user's guide is provided in PDF format on the Documentation USB card.

Help system
The help system installed with BD FACSDiva™ software includes the documents listed below. Access the
BD FACSymphony™ A1 help system from the Help menu in the BD FACSDiva™ software. Internet access is not
required to use the help system.

The help system includes the following documents:

10 BD FACSymphony™ A1 Flow Cytometer User's Guide
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l BD FACSDiva™ Software Reference Manual: Includes instructions or descriptions for installation and setup,
workspace components, acquisition controls, analysis tools, and data management. Access this manual from
the BD FACSDiva™ Software Help menu (Help > Documentation > Reference Manual), or by double-clicking
the shortcut on the desktop.

l BD Cytometer Setup and Tracking Application Guide: Describes how to use the BD® Cytometer Setup and
Tracking (CS&T) features in BD FACSDiva™ software.

Instrument technical support

Introduction
This topic describes how to get technical assistance.

Contacting technical support
If technical assistance is required, contact your local BD Biosciences customer support representative or
supplier.

When contacting BD Biosciences, have the following information available:
l Product name, part number, and serial number
l Version of BD FACSDiva™ software you are using
l Any error messages
l Details of recent system performance

To contact customer support:
1. Go to bdbiosciences.com.
2. Select your region. You will see information in your local language.
3. Click Go.
4. Click the Support link for details for your local region.

Chapter 1  About this guide 11
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2
2

Introduction
This chapter covers the following topics:
l System overview (page 14)
l Cytometer overview (page 15)
l Control panel (page 17)
l Fluidics system (page 18)
l Sheath and waste tanks (page 23)
l Optics (page 24)
l Workstation (page 25)
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System overview

About the system
The BD FACSymphony™ A1 system includes the BD FACSymphony™ A1 flow cytometer, BD FACSDiva™
software running on the system workstation, the optional BD FACSFlow™ supply system (FFSS), and the
optional BD® High Throughput Sampler (HTS). Each component is described in detail in the following sections.

In addition, the BD® Small Particle Detector (SPD) is an optional side scatter detector optimized to improve
resolution of small particles such as extracellular vesicles. For more information, see Small Particle Detector
(page 107).

TM

321

Number Components

1 Sheath and waste tanks

2 BD FACSymphony™ A1 flow cytometer

3 Computer workstation

14 BD FACSymphony™ A1 Flow Cytometer User's Guide
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Cytometer overview

Introduction
The BD FACSymphony™ A1 flow cytometer is an air-cooled multi-laser benchtop flow cytometer with the ability
to acquire 14 or 16 fluorescent parameters. It uses fixed-alignment lasers that transmit light through a flow cell
to collect and translate the resulting fluorescence signals into electronic signals. Cytometer electronics convert
these signals into digital data.

Components
The following figures show the main components on the front and right side of the BD FACSymphony™ A1 flow
cytometer. The descriptions are listed in the tables.

TM

5

4

3

2

1

Number Component

1 Heat ventilation slots (top)

2 Control panel

3 Sample injection port (SIP)

4 Heat ventilation slots (left side)

5 Optics access door (polygon detector arrays)
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6

5

4

3

2

1

Number Component

1 Red laser detector array access panel

2 Power button

3 Electrical plug

4 Fluidic sensor ports

5 Air and fluidic ports

6 USB port for Small Particle Detector to workstation

Do not place any objects on top of the instrument. Blocking the ventilation may cause the
instrument to overheat.

Do not place liquids on top of the instrument. Any spill of liquid into the ventilation openings could
cause electrical shock or damage to the instrument.

16 BD FACSymphony™ A1 Flow Cytometer User's Guide

Status: Released EFFECTIVEDocument: 23-23437 Doc Type: ZLU
Change #: 500000344050Revision: 02

Version: BUsage: Production Usage Classification: ConfidentialPrint Date: 22-Apr-2025 22:28:10 GMT Daylight Time
Valid From: 27-Jun-2024 To: 31-Dec-9999 Doc Part: EN



Control panel

Overview
The fluidics display controller enables the monitoring of the sheath tank level, waste tank level, and air pressure
status through a combination of status LEDs and text display. It also controls sample flow rate and fluidic
controls.

The following figure shows the components in the control panel, which are listed in the table.

6

543

21

Number Component

1 System status and activity bar

2 Fluid control buttons

3 Sample flow rate buttons

4 Sample fine adjust buttons

5 MODE button

6 Touch screen and status display

More information
l Fluidics system (page 18)
l Optics (page 24)
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Fluidics system

Introduction
The fluidics system carries the sample out of the sample tube and into the interrogation region of the flow cell.
Cells are carried in the sample core stream in single file and measured individually.

Note: If your system has the HTS option, see the BD® High Throughput Sampler User's Guide for additional
information on the sample flow rates and fluidic controls.

System indicators
There are two system indicators (System Status and Activity) on the control panel as well as Sheath Tank Air
Pressure, Sheath, and Waste indicators on the graphic display.
l System Status bar. Shows the status of the system by displaying a green, yellow, or red LED indicator. The

following table describes the LED indicators, conditions that trigger them, and any action that must be
taken.

LED
color

Status Action Condition

Green Good None Good

Yellow Sheath and/or waste tanks need
attention.

Check tank levels Sheath low and/or waste
nearly full

Red Take immediate action. l Empty waste tank
l Fill sheath tank
l Check air pressure

Sheath empty and/or
waste full

Air pressure is out of
specification

System status is also displayed on the Status screen. See Status screen (page 20) for a description of the
Status screen.

l Activity. Shows whether the cytometer power is on and the status of acquisition. The following table
describes the indicator LEDs, and status that triggers them.

Indicator LED color Status

Steady pulse blue Cytometer is powered on

Fluctuates blue Forward scatter is registering cells or particles

Fluid control
The three fluid buttons (RUN, STANDBY, and PRIME) control the fluidics subsystem.
l RUN Pressurizes the sample tube to transport the sample through the sample injection tube and into the

flow cell.
The RUN button is green when the sample tube is on and the support arm is centered and the sample tube is
pressurized. When the tube support arm is moved left or right to remove a sample tube, the cytometer
switches to an automatic standby status to conserve sheath fluid, and the RUN button changes to orange.
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The RUN button will also turn orange if the sample tube is cracked or the BAL seal is bad. See
Troubleshooting (page 91).

l STANDBY Stops fluid flow to conserve sheath fluid.
When you leave the cytometer for more than a few minutes, place a tube containing less than 1 mL of
deionized (DI) water on the sample injection port (SIP) and press STANDBY.

l PRIME Prepares the fluidics system by draining and filling the flow cell with sheath fluid.

Note: Remove sample tubes during the prime cycle.
The fluid flow initially stops, and pressure is reversed to force fluid out of the flow cell and into the waste
container. After a preset time, the flow cell fills with sheath fluid at a controlled rate to prevent bubble
formation or entrapment. At completion, the cytometer switches to standby mode.

Sample flow rate control
The three flow rate buttons (LOW, MED, HIGH) control the sample rate through the flow cell. The three fluidic
control buttons (RUN, STANDBY, PRIME) enable you to control the sample acquisition rate.

21

Number Component

1 Sample flow rate buttons

2 Sample fine adjust buttons

When sample adjust is set to 250 (as shown on the status screen on the control panel) the sample flow rates at
the Low, Med, and High settings are approximately 12, 35, and 60 µL/min of sample, respectively. Each time
you press one of the SAMPLE ADJ buttons, the fine adjust of the indicated sample increases or decreases by 10.
The following table shows the approximate sample flow rate range for low, medium, and high.

Settings Sample flow rate (µL/min)

Low 6–24

Med 17.5–70

High 30–120
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Status screen
The status screen display is a touchscreen color LCD screen which displays operational data while the system is
running and toggles between two different displays: Normal Mode and Setup Mode.

Normal Mode displays the current settings of the Fine Adjust Potentiometer, the three programmable
potentiometer Set Points, Sheath Tank Pressure Status, Sheath Level, and Waste Level while the system is
running.

The Normal Mode screen is shown in the following illustation.

SETPOINT 1 SETPOINT 2 SETPOINT 3
SETPOINT

FUNCTION

SETUP

MODE

FINE ADJUST PRESSURE

HIGH

GOOD

LOW

SHEATH WASTE

654

32

1

7

Number Definition

1 Fine Adjust. Shows the current setting of fine adjust. The slider enables quick changes to the potentiometer
setting by moving the slider up or down. Fine adjust can be set in increments of 10 from 0 to 500. The
normal set point is 250. The last value persists, even after cytometer shutdown.

2 Sheath Level. Shows range from 0 to 100. The display line decreases from top to bottom in sequences of
20% from full level. System status turns yellow at 20%, and red at 0%.

3 Waste Level. Shows range from 0 (empty) to 100 (full). The display line increases from bottom to top in
sequences of 20%. System status turns yellow at 80%, and red at 100% full.

4 Setpoint. Stores up to three potentiometer setpoints. A setpoint is set by tapping the Setpoint Function
button, moving the Fine Adjust slider up or down to the desired point, and tapping one of the setpoint
buttons. The Setpoint enables you to store three different settings and quickly change between them.

5 Setpoint Function. Button enables the setting of a Setpoint.

6 Setup Mode. Button to enter Setup Mode (Setup Mode can also be entered by pushing the Mode button on
the control panel).

7 Alarm Silenced Indicator.When the alarm sounds are silenced, the indicator will turn on.
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Setup Mode displays the current settings of Sound, FFSS Mode, and Altitude while the system is running. The
Setup Mode screen is shown in the following illustation.

SETUP
ALTITUDE

(METERS)

SOUND

FFSS

SW Revision Ø6

2000

1500

1000

500

0

-500

OFF

EXIT SETUP

4

3

2

1

Number Definition

1 Sound. Turns the warning alarm sounds on or off. To turn off the alarm, slide the slider to the left position.
To turn on the alarm, slide the slider to the right position. A green light indicates the alarm is active. A red
light indicates the alarm is inactive.

2 FFSS Mode. Turns FFSS Mode on or off. To turn off FFSS Mode, slide the slider to the left position. To turn on
FFSS Mode, slide the slider to the right position. A green light indicates FFSS Mode is active. A red light
indicates FFSS Mode is inactive.

3 Exit Setup. Button to exit Setup Mode.

4 Altitude. Shows the current setting of Altitude. The slider enables quick changes to the Altitude setting by
moving the slider up or down. Altitude can be set from -500 to 2000 meters. Sliding the slider down to the
Off position turns the air pressure warning off.

Fluidic alarms and the Mode button
The fluidic alarms are triggered by the waste and sheath fluid levels in the tanks and by low or high sheath tank
air pressure levels. The alarms sound when the waste tank is nearly 100% full and the sheath tank is empty. The
fluidic alarms and system status will also show warnings when you start up the cytometer until the tank
pressure reaches the correct level.

To silence the alarm sounds, press the Setup Mode in the touchscreen. Slide the Sound slider to the left. To turn
the alarm sounds back on, slide the Sound slider to the right. If the alarm sounds are turned off, the Normal
Mode screen will also indicate the sounds are off.

Note: The system status indicators are not affected by the alarm sounds on/off state.

Turning off the sound may result in overflow of waste and may result in running out of sheath fluid.

Note:When the cytometer is in FFSS mode, both visual and audible alarms are deactivated.

Note: The function of the system is sensitive to air pressure for flow rates. The system needs to know the
altitude, in meters, of the location of the system in order to accurately report the air pressure.
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Sample injection port (SIP)
The SIP is where the sample tube is installed. The SIP includes the sample injection tube (SIT) and the tube
support arm. Samples are introduced through a stainless steel injection tube equipped with an outer droplet
containment sleeve. The sleeve works in conjunction with a vacuum pump to eliminate droplet formation of
sheath fluid as it backflushes from the sample injection tube.

3

2

1

Number Component

1 Outer sleeve

2 Sample injection tube (SIT)

3 Tube support arm

Sample injection tube (SIT). Stainless steel tube that carries sample from the sample tube to the flow cell. This
tube is covered with an outer sleeve that serves as part of the droplet containment system.

Tube support arm. Arm that supports the sample tube and activates the droplet containment system vacuum.
The vacuum is on when the arm is positioned to the side and off when the arm is centered.

Note: If a sample tube is left on the SIP with the tube support arm to the side (vacuum on), the sample will be
aspirated into the waste container.

Precautions when using the HTS option
When using the BD FACSymphony™ A1 flow cytometer with the HTS, ensure that the HTS is
completely pushed into the operating position before removing the droplet containment module
(DCM) sleeve or disconnecting the sample coupler from the SIP. This is to avoid accidental leakage
of potentially biohazardous liquids directly onto the instrument. With the HTS in the proper location,
the containment dish with padding is directly below the SIP.

If you are using the HTS option, always slide the HTS mount slowly to prevent sample cross-
contamination when the wells are full. Never move the HTS when it is in operation.

Do not lean on or put any weight on the HTS as it could damage the instrument.
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Droplet containment module
The DCM prevents sheath fluid from dripping from the SIP and provides biohazard protection.

The DCM vacuum is activated when the tube support arm is moved to the side. Sheath fluid is aspirated as it
backflushes the sample injection tube. This backflush helps prevent carryover of cells between samples.

Sheath and waste tanks

Introduction
This topic describes the sheath and waste tanks. The sheath and waste tanks are outside the cytometer and
can be positioned on the floor.

Note: Only BD service engineers should change the location of the sheath and waste tanks.

If you are using the BD FACSFlow™ supply system (FFSS), see the BD FACSFlow™ Supply System User’s Guide
for more information.

Sheath tank
The sheath tank has a capacity of 10 L. Sheath fluid is filtered through an in-line, interchangeable filter that
prevents small particles from entering the sheath fluid lines. An alarm sounds when the tank is empty.

Do not fill the sheath tank to its maximum capacity. When an overfull tank is pressurized, erratic
cytometer performance can result.

Waste tank
The waste tank has a capacity of 10 L. An alarm sounds when the tank is full.

Cable management
Arrange the cables, air lines, and fluidics lines from the instrument to the sheath and waste tanks away from
high traffic area. Also ensure that the cables and lines are placed so they do not interfere with normal
instrument operation.

Routing the cables and lines from the back of the instrument to the underside of the table and then to the
tanks is preferable. Any excess lines or tubing should be loosely coiled but out of the way of the tanks.

More information
l Preparing the sheath tank (page 29)
l Preparing the waste tank (page 32)
l Status screen (page 20)
l Fluidic alarms and the Mode button (page 21)
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Optics

Introduction
This topic describes the optical components for the BD FACSymphony™ A1 flow cytometer including:
l Detector arrays
l Lasers
l Optical filters
l Signal detectors

Detector arrays
The BD FACSymphony™ A1 detector arrays consist of polygons. Each polygon can be configured with one to six
fluorescent detectors. The configuration of detectors may limit the actual number of detectors on each
polygon. To access the red laser detector array, see Accessing the red laser detector array (page 51).

Lasers
The BD FACSymphony™ A1 flow cytometer is configured with four lasers as listed in the following table.

Laser Wavelength (nm) Power (mW)

Blue 488 100

Red 637 100

Violet 405 100

Yellow Green 561 100

Optical filters
Optical filters attenuate light or help direct it to the appropriate detectors. The name and spectral
characteristics of each filter appear on its holder.

There are two types of optical filters in the BD FACSymphony™ A1:
l Longpass dichroic filters (LPs) Transmit wavelengths at or longer than the specified value and reflect all

light below the specified wavelength.
l Bandpass filters (BPs) Pass a narrow spectral band of light.

When dichroic filters are used as steering optics to direct different color light signals to different detectors, they
are called dichroic mirrors. Longpass dichroic mirrors transmit longer wavelengths to one detector while
reflecting shorter wavelengths to a different detector.

The BD FACSymphony™ A1 flow cytometer polygon detector arrays use dichroic longpass mirrors on the inside,
and bandpass filters on the outside of the filter holders.
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Signal detectors
Light signals are generated as particles pass through the laser beam in a fluid stream. When these optical
signals reach a detector, electrical pulses are created that are then processed by the electronics system.

There are two types of signal detectors in the BD FACSymphony™ A1 flow cytometer:
l Photomultiplier tubes (PMTs). Used to detect the weaker signals generated by side scatter and all

fluorescence channels. These signals are amplified by applying a voltage to the PMTs.
l Photodiodes. Less sensitive to light signals than the PMTs. A photodiode is used to detect the stronger

forward scatter (FSC) signal.

More information
l Optical filter theory (page 82)
l About configurations (page 102)

Workstation

Introduction
This topic describes the components of the BD FACSymphony™ A1 workstation.

Workstation components
Acquisition, analysis, and most instrument functions are controlled by the BD FACSymphony™ A1 workstation.
It includes a PC and one or two monitors.

Your workstation is equipped with the following:
l Microsoft Windows operating system
l BD FACSDiva™ software version 9.0.2 or later for data acquisition and analysis
l Software documentation including the help system

More information
l About the BD FACSymphony™ A1 documentation (page 10)
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3
3

Cytometer setup
This chapter covers the following topics:
l Starting the cytometer and computer (page 28)
l Preparing the sheath tank (page 29)
l Removing air bubbles (page 31)
l Preparing the waste tank (page 32)
l Preparing the fluidics (page 34)
l About the optical filters and mirrors (page 36)
l Custom configurations and baselines (page 37)
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Starting the cytometer and computer

Introduction
This topic describes how to start the cytometer and turn on the computer.

Note: If your system is using the BD FACSFlow™ supply system, make sure that the BD FACSFlow™ supply
system is powered on before the cytometer.

Procedure
To start the cytometer:
1. Turn on the power to the flow cytometer.

Allow 30 minutes for the optical system temperature to stabilize.

Failure to warm up and stabilize the instrument could affect sample data.

2. Turn on the computer and log in to Windows.

Note: You can turn on the power to the flow cytometer and the workstation in any order.
3. Start BD FACSDiva™ software by double-clicking the shortcut on the desktop, and log in to the software.
4. Check the Cytometer window in BD FACSDiva™ software to ensure that the cytometer is connected to the

workstation.
The cytometer connects automatically. While connecting, the message Cytometer Connecting is displayed in
the status area of the Cytometer window. When connection completes, the message changes to Cytometer
Connected.

If the message Cytometer Disconnected appears, see Electronics troubleshooting (page 97).
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Preparing the sheath tank

Introduction
This topic describes how to prepare the sheath tank.

Note: If your system is using the BD FACSFlow™ supply system, see the BD FACSFlow™ Supply System User’s
Guidefor more information.

When to check the sheath tank
Check the fluid levels in the sheath tank every time you use the cytometer. This ensures that you do not run out
of sheath fluid during an experiment.

Sheath tank components

7

6

5

4

3

2

1

Number Component

1 Cap handle

2 Filter assembly

3 Sheath fluid line (blue) to sheath tank

4 Air line (green)

5 Alarm sensor

6 Clamp knob
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Number Component

7 Vent valve

Procedure
Note: Be careful to avoid damaging the alarm sensor line or any of the tubing when disconnecting and filling
the sheath tank.

To prepare the sheath tank:
1. Verify that the flow cytometer is in standby mode.

Press the STANDBY button on the control panel if necessary.
2. Disconnect the green air line and blue sheath fluid line from the sheath tank.
3. Disconnect the alarm line from the alarm sensor socket by pulling lightly on both ends of the plug. See the

following illustration.

2

3

1

Number Component

1 Alarm sensor socket

2 Alarm sensor line

3 Disconnect at this point

4. Depressurize the sheath tank by pulling up on the vent valve.
5. Remove the sheath tank lid.

Unscrew the clamp knob and push down to loosen, if necessary. Tilt the cap to the side to remove it from the
tank.

6. Add up to 10 L of sheath fluid, such as BD FACSFlow™ solution, to the sheath tank.

Note: 10 L will reach the interior line on the sheath tank. Do not fill the sheath tank further.
7. Replace the sheath tank lid.
8. Make sure the gasket on the inside lip of the sheath lid is seated correctly and has not slipped out of

position.

Note: If the gasket is not seated correctly, the tank will not pressurize properly.
9. Close the sheath lid and tighten the clamp knob to finger-tight.

10. Reconnect the green air line, alarm line and the blue sheath line.
Ensure that the blue sheath fluid line is not kinked.

Note: Make sure the alarm sensor socket is off the ground by looping the line through the handle of the
sheath tank.
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More information
l Removing air bubbles (page 31)
l Changing the sheath filter (page 45)
l Cleaning or replacing the sheath gasket (page 51)

Removing air bubbles

Introduction
This topic describes how to remove trapped air bubbles in the sheath filter and the sheath line. Air bubbles can
occasionally dislodge and pass through the flow cell, resulting in inaccurate data.

Note: Perform this activity every time the sheath tank is refilled.

Procedure
To remove air bubbles:
1. Check the sheath filter for trapped air bubbles.

1

2

3

Number Components

1 Cytometer fluid line (roller clamp not visible)

2 Vent fitting

3 Vent line
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2. If bubbles are visible, gently tap the filter body with your fingers to dislodge the bubbles and force them to
the top.

When removing air bubbles, do not vigorously shake, bend, or rattle the sheath filter or you
might damage it.

3. Direct the vent line into a beaker and press the small button at the end of the vent fitting against the side of
the beaker until a steady stream of fluid empties from the filter.

2

1

Number Components

1 Button

2 Vent fitting

4. Tilt the filter and verify that no trapped air remains in the filter.
5. Repeat steps 3 and 4 until no air is observed in the filter.
6. Check the sheath line for air bubbles.
7. Open the roller clamp at the fluidics interconnect (if necessary) to bleed off any air in the line. Collect any

excess fluid in a waste container.

Note: The roller clamp can be found close to the fluidics ports of the cytometer.
8. Close the roller clamp.

Preparing the waste tank

Introduction
This topic describes how to prepare the waste tank. Prevent waste overflow by emptying the waste tank daily or
whenever the system status indicator turns yellow.

Note: If your system is connected to the FFSS, see the BD FACSFlow™ Supply System User’s Guide for more
information.

All biological specimens and materials coming into contact with them are considered biohazardous.
Handle as if capable of transmitting disease. Dispose of waste using proper precautions and in
accordance with local regulations. Never pipette by mouth. Wear suitable protective clothing,
eyewear, and gloves.
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Waste tank components
The following figure shows the main components of the waste tank.

3

4

51

2

Number Component

1 Moisture trap

2 User replaceable cap

3 Air line

4 Alarm sensor

5 Waste fluid line

Biological precautions
Contact with biological specimens and materials can transmit potentially fatal disease.

To prevent exposure to biohazardous agents:
l Put the cytometer in standby mode before disconnecting the waste tank to avoid leakage of biohazardous

waste.
l Always disconnect the waste tank from the cytometer before you empty it. Wait at least 30 seconds for

pressure to dissipate before you remove the waste cap or sensor.
l Expose waste tank contents to bleach (10% of total volume) for 30 minutes before disposal.
l Do not wet the waste tank cap. If wet, the filter in the cap will cause the tank to malfunction. To keep the

cap dry, place it on the bench label side up when it is not on the tank.
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Procedure
To prepare the waste tank:
1. Verify that the flow cytometer is in standby mode.

Press the STANDBY button on the control panel if necessary.
2. Disconnect the orange waste tubing from the waste tank.
3. Disconnect the alarm line from the alarm sensor socket by pulling lightly on both ends of the plug. See the

following illustration.

2

3

1

Number Component

1 Alarm sensor socket

2 Alarm sensor line

3 Disconnect at this point

Keep the lid and moisture trap on the waste tank until you are ready to empty it.
4. Remove the lid and moisture trap before emptying the waste tank. Keep the cap label side up at all times.

Empty the waste tank.

The waste tank is heavy when full. When emptying it, use good body mechanics to prevent
injury.

5. Add approximately 1 L of bleach to the waste tank and close it. Reattach the moisture trap and lid.
6. Reconnect the orange waste tubing and make sure it is not kinked.
7. Reconnect the black alarm sensor line.

Note: Make sure the alarm sensor socket is off the ground by looping the line through the handle of the
waste tank.

Preparing the fluidics

Introduction
This topic describes how to prepare the fluidics system.

When to prime the fluidics
Sometimes, air bubbles and debris may become lodged in the flow cell. This is indicated by excessive noise in
the forward and side scatter parameters (FSC and SSC, respectively). In these cases, it is necessary to prime the
fluidics system. Priming introduces air to the flow cell. Performing the following procedures should minimize the
need for priming and make priming more effective when needed.
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Procedure
Start up the fluidics:
1. Turn on the computer and instrument as described in Starting the cytometer and computer (page 28).
2. Install a tube with 3 mL of 1.5% dilution of BD® Detergent Solution Concentrate on the SIP and put the

tube support arm underneath the tube.

Note: The BD® Detergent Solution Concentrate must be diluted before use. Mix one full 15 mL bottle of
BD® Detergent Solution Concentrate into 985 mL of DI water to make 1 L total.

3. Press RUN and HIGH on the cytometer fluid control panel. Run for 10 minutes.
4. Remove the tube of detergent from the SIP and replace with a tube containing 3 mL of DI water.
5. Press RUN and HIGH on the cytometer fluid control panel. Run for 10 minutes.

Determine whether or not the fluidics need to be debubbled by priming:
1. Open or create an experiment to view BD® CS&T Beads. For details on using the beads, see Running a

performance check (page 57).
2. Create a new tube in the experiment.
3. Load a tube of BD® CS&T Beads.

4. Press RUN and LOW on the cytometer fluid control panel.
5. Observe the plots for the scatter channel and fluorescent channels. There should be two distinct peaks for

each scatter channel and three distinct peaks for each fluorescent channel. The coefficient of variation (CV)
for bright peaks should be narrow. If either the CVs are very wide on a detector or no signal is observed, the
fluidics need to be primed as described in the following procedure.

To prime the fluidics:

1. Move the tube support arm to the side
2. Remove tube from the SIP or leave the HTS connected to the SIT.
3. Press the PRIME fluid control button to force the fluid out of the flow cell and into the waste container.

Once drained, the flow cell automatically fills with sheath fluid at a controlled rate to prevent bubble
formation or entrapment. The STANDBY button turns amber after completion.

4. When Standby light is on, install a tube of DI water or leave the HTS hooked up to the SIT.
5. Press the RUN fluid control button and run for 10 seconds.
6. Press the PRIME button immediately followed by the RUN button.
7. Repeat step 6 ten times. If more than 2 seconds pass between Prime and Run in step 4, restart the

procedure
8. Install a 12 × 75 mm tube with 1 mL of DI water on the SIP and place the support arm under the tube.

Leave the cytometer in standby mode.

More information
l Cytometer troubleshooting (page 92)
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About the optical filters and mirrors

Introduction
This topic provides a description of the optical filters and mirrors.

Filter and mirror configurations
Each detector has an optic holder in front of it. The optic holders are labeled with numbers indicating the
wavelengths of the bandpass filter and longpass dichroic mirror they contain (for example, 780/60 and 750 LP,
respectively). The optic holder in front of the last detector in the detector array contains only a bandpass filter
and is marked accordingly.

1

2

3

3

Number Components

1 PMT A

2 Optic holder handle

3 Optic holders

The filters steer progressively shorter wavelengths of light to the next detector in the array as indicated by the
lines and arrows on the top of the polygon.
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Optic holders, filters, and mirrors
Optic holders house filters and mirrors. Your cytometer includes several blank (empty) optic holders.

To ensure data integrity, do not leave any slots empty in a detector array when you are using the
associated laser. Always use a blank optic holder.

Base configurations
Each BD FACSymphony™ A1 flow cytometer has a base cytometer configuration that corresponds to the layout
of the installed lasers and optics in your cytometer. This base configuration is set by your field service engineer.

BD FACSDiva™ cytometer configuration
Before you acquire data using BD FACSDiva™ software, you must specify a cytometer configuration. The
cytometer configuration defines which filters and mirrors are installed at each detector.

BD FACSDiva™ software provides a BD base configuration for your BD FACSymphony™ A1 flow cytometer.
Select Cytometer > View Configuration to create, modify, or delete custom cytometer configurations. (See the
Cytometer and Acquisition Controls chapter of the BD FACSDiva™ Software Reference Manual for details.)

More information
l About configurations (page 102)

Custom configurations and baselines

Introduction
This topic describes where to find information on how to create a custom configuration and define a baseline
for a performance check.

Overview
BD Cytometer Setup and Tracking (CS&T) software is used to define the baseline performance of your
cytometer. A baseline provides a starting point for the tracking of cytometer performance. When running a
performance check, you compare the results to the baseline.

See Optimizing cytometer settings (page 53). Also see the BD Cytometer Setup and Tracking Application Guide
for information on creating custom configurations and defining a baseline.

More information
l Running a performance check (page 57)
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4
4

Maintenance
This chapter covers the following topics:
l Maintenance overview (page 40)
l Cleaning the fluidics (page 41)
l Shutting down the cytometer (page 42)
l Flushing the system (page 42)
l Replacing the waste tank cap (page 44)
l Changing the sheath filter (page 45)
l Changing the Bal seal (page 48)
l Changing the sample tube O-ring (page 50)
l Cleaning or replacing the sheath gasket (page 51)
l Accessing the red laser detector array (page 51)
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Maintenance overview

Introduction
This topic provides an overview of the BD FACSymphony™ A1 flow cytometer routine maintenance and
cleaning procedures.

General use guidelines
Contact with biological specimens and materials can transmit potentially fatal disease.

Follow these guidelines whenever operating or maintaining the cytometer:
l Wear suitable protective clothing, eyewear, and gloves.
l Handle all biological specimens and materials in accordance with applicable regulations and manufacturer

specifications.
l Dispose of waste using proper precautions and in accordance with local regulations.
l Never pipette by mouth.

For fluidics maintenance, we recommend the following cleaning solutions:
l BD FACSClean™ solution
l BD® Detergent Solution Concentrate
l 10% bleach solution

Use DI water to dilute bleach to appropriate concentrations.

Higher concentrations of bleach and use of other cleaning solutions might damage the cytometer.

When to perform maintenance procedures
Perform maintenance procedures in the following frequencies.

Frequency Maintenance procedure

Daily l Cleaning the fluidics (page 41)
l Shutting down the cytometer (page 42)

Scheduled (every 2 weeks) l Flushing the system (page 42)

Periodic (frequency depends on how often you run the cytometer) l Changing the sheath filter (page 45)
l Changing the Bal seal (page 48)
l Changing the sample tube O-ring (page 50)
l Cleaning or replacing the sheath gasket (page

51)
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Cleaning the fluidics

Introduction
This topic describes how to perform the daily fluidics cleaning.

Overview
Cleaning the fluidics daily prevents the sample injection tube from becoming clogged and removes dyes that
can remain in the tubing.

In addition to daily cleaning, follow this procedure immediately after running viscous samples or nucleic acid
dyes such as Hoechst, DAPI, propidium iodide (PI), acridine orange (AO), or thiazole orange (TO).

Procedure
To clean the fluidics:
1. Press RUN and HIGH on the cytometer fluid control panel.
2. Install a tube containing 3 mL of a 10% bleach solution on the SIP with the support arm to the side (vacuum

on) and let it run for 1 minute.
3. Move the tube support arm under the tube (vacuum off) and allow the cleaning solution to run for 5

minutes with the sample flow rate set to HIGH.
4. Repeat steps 2 and 3 with a 1.5% dilution of BD® Detergent Solution Concentrate.

Note: The BD® Detergent Solution Concentrate must be diluted before use. Mix one full 15 mL bottle of
BD® Detergent Solution Concentrate into 985 mL of DI water to make 1 L total.

Never mix BD® Detergent Solution Concentrate and bleach because they create chlorine gas.

5. Repeat steps 2 and 3 with DI water.
6. Press the STANDBY button on the fluidics control panel.
7. Place a tube containing less than 1 mL of DI water on the SIP.

A tube with less than 1 mL of DI water should remain on the SIP to prevent salt deposits from forming in the
injection tube. This tube also catches back drips from the flow cell.

Do not leave more than 1 mL of water on the SIP. When the instrument is turned off or left in
standby mode, a small amount of fluid will drip back into the sample tube. If there is too much
fluid in the tube, it could overflow and affect the cytometer performance.
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Shutting down the cytometer

Before you begin
Each time you shut down the cytometer, perform the daily cleaning as described in Cleaning the fluidics (page
41).

Procedure
To shut down the cytometer:
1. Place a tube of DI water on the SIP.
2. Turn off the flow cytometer.
3. Close BD FACSDiva™ software.
4. Select Start > Shutdown to turn off the computer (if needed).
5. If your system is connected to the FFSS, shut off the FFSS.

If the cytometer will not be used for a week or longer, perform a system flush and leave the fluidics system filled
with DI water to prevent saline crystals from clogging the fluidics.

More information
l Cleaning the fluidics (page 41)
l Flushing the system (page 42)

Flushing the system

Introduction
This topic describes how to perform an overall fluidics cleaning to remove debris and contaminants from the
sheath tubing, waste tubing, and flow cell. Perform the system flush at least every 2 weeks. The flush should be
performed more often when the system is first installed or after a major fluidics repair.

Note: If you are using the BD FACSFlow™ supply system, see the BD FACSFlow™ Supply System User’s Guide for
instructions on flushing the system.

The cytometer hardware might be contaminated with biohazardous material. Use 10% bleach to
decontaminate the instrument.

Procedure
To perform a system flush:
1. Remove the sheath filter.

a. Press the quick-disconnects on both sides of the filter assembly.
b. Remove the filter assembly.
c. Connect the two fluid lines.
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Do not run detergent, bleach, or ethanol through the sheath filter. They can break down the
filter paper within the filter body, causing particles to escape into the sheath fluid, possibly
clogging the flow cell.

2. Empty the sheath tank and rinse it with DI water.
3. Fill the sheath tank with at least 1 L of BD FACSClean™.
4. Empty the waste tank, if needed.
5. Open the roller clamp by the fluidics interconnect, and drain the fluid into a beaker for 5 seconds.
6. Remove the DI water tube from the SIP.
7. Prime the instrument twice:

a. Press the PRIME button on the fluidics control panel.
b. When the STANDBY button light is amber, press the PRIME button again.

8. Install a tube with 3 mL of BD FACSClean™ on the SIP and put the tube support arm underneath the tube.
See Maintenance overview (page 40) for other recommended cleaning solutions.

9. Press RUN and HIGH on the cytometer fluid control panel. Ensure that the sample fine adjust is set to 250.
Run for 30 minutes.

10. Press the STANDBY fluid control button and depressurize the sheath tank by lifting the vent valve.

11. Empty the waste tank to avoid the mixing of bleach and BD® Detergent Solution Concentrate.

Never mix BD® Detergent Solution Concentrate and bleach because they create chlorine gas.

12. Repeat steps 2 through 11 with 1.5% BD® Detergent Solution Concentrate.

Note: The BD® Detergent Solution Concentrate must be diluted before use. Mix one full 15 mL bottle of
BD® Detergent Solution Concentrate into 985 mL of DI water to make 1 L total.

13. Leave the system filled with 1.5% dilution of BD® Detergent Solution Concentrate overnight to soak (if
possible, up to 18 hours) to reduce air adhesion throughout the system. When soaking, the system power
should be disconnected and secured. Upon completion of the soak period, restore power and continue to the
next step in this procedure .

14. Repeat steps 2 through 11 with DI water.
15. Replace the sheath filter and refill the sheath tank with sheath fluid.
16. Install a tube with less than 1 mL of DI water onto the SIP.
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Replacing the waste tank cap

Introduction
This topic describes how to replace the waste tank cap. Replace the cap once a month.

Biological precautions
Contact with biological specimens and materials can transmit potentially fatal disease.

To prevent exposure to biohazardous agents:
l Put the cytometer in standby mode before disconnecting the waste tank to avoid leakage of biohazardous

waste.
l The waste tank can become pressurized when the cytometer is running. Always disconnect the waste tank

from the cytometer before you empty it. Wait at least 30 seconds for pressure to dissipate before you
remove the waste cap or sensor.

l Expose waste tank contents to bleach (10% of total volume) for 30 minutes before disposal.
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Procedure
To replace the cap:
1. Put the cytometer in standby mode.
2. Disconnect the orange waste line from the waste tank.
3. Disconnect the alarm sensor line from the alarm sensor socket.

Note:Wait at least 30 seconds for pressure to dissipate.
4. Remove the waste cap and attached trap from the tank and place on the bench label-side up.
5. Detach the cap from the trap.
6. Place a new cap on the trap.
7. Write the date in the white space on the cap label.

338677 Rev A

Waste (A)

8. Screw the cap assembly onto the waste tank and hand-tighten until it is fully closed.

To prevent waste tank overpressurization, do not overtighten the trap or attached filter cap.
Tighten each component only until it is hand-tight. Do not use sealants such as Teflon® tape or
other adhesives.

9. Re-attach the alarm sensor line and waste line to the waste tank.

Changing the sheath filter

Introduction
This topic describes how to change the sheath filter. The sheath filter is connected in-line with the sheath line. It
filters the sheath fluid as it comes from the sheath tank.

When to change the sheath filter
We recommend changing the sheath filter assembly every six months. Increased debris appearing in an FSC vs
SSC plot can indicate that the sheath filter needs to be replaced. See Supplies and consumables (page 119) for
ordering information.

When working with the small particle detector, we recommend using a sheath filter with a pore size smaller
than the particles of interest.

Confirm you have a new sheath filter and Teflon® tape before you start the procedure.
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Sheath filter assembly

10

9

2

4

5

8

6

7

1

3

Number Components Number Components

1 Sheath line to cytometer 6 Filter base

2 Quick-disconnect 7 Quick-disconnect

3 Post-filtered sheath line 8 Sheath fluid line from tank

4 Hose clamp 9 Vent fitting

5 Sheath filter 10 Vent line
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Removing the old filter
To remove the old filter:
1. Place the cytometer in standby mode.
2. Remove the sheath filter assembly by pressing the quick-disconnect on both sides of the filter assembly.

3. To replace the standard sheath filter, continue the steps in this section, then move to Attaching the new
standard filter (page 47).

4. Over a sink or beaker:
l Remove the vent line from the filter and save it to use again.
l Remove the filter base and save it to use again.
l Remove the post-filtered sheath line by using a screwdriver to gently pop the hose camp off the filter and

save it to use again.
5. Discard the used filter in an appropriate receptacle.

Attaching the new standard filter
To attach the new standard filter:
1. Connect the vent line to the new sheath filter assembly. Twist to attach.
2. Wrap Teflon® tape around the filter threads, then connect the filter to the filter base.

3. Install the hose clamp onto the post-filtered sheath line then attach it to the filter.
4. Connect the sheath line (coming from the sheath tank) to the filter assembly via the quick-disconnect.
5. Connect sheath line (going into the cytometer) to the post-filtered sheath line via quick-disconnect

Note: Ensure that the new filter is installed with the directional flow arrow pointing toward the sheath line
that goes to the cytometer.

6. Confirm that the cytometer is on.
7. Direct the vent line into a receptacle and press the small button at the end of the vent fitting against the

side of the receptacle until a steady stream of fluid empties from the filter.
8. Tilt the filter and verify that no trapped air remains in the filter.
9. Repeat steps 7 and 8 as necessary to remove all trapped air.

10. If necessary, to remove trapped air in the filter and sheath line, dispense fluid from sheath line via the roller
clamp that is connected to the sheath line past the sheath filter assembly. See Removing air bubbles (page
31).
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Changing the Bal seal

Introduction
This topic describes how to replace the Bal seal.

The sample injection tube Bal seal is a ring that forms a seal with the sample tube and ensures proper tube
pressurization.

When to change the Bal seal
Over time, the Bal seal becomes worn or cracked and requires replacement. Replacement is necessary if a
proper seal is not formed when a sample tube is installed on the SIP. Indications that a proper seal has not
formed include:
l The tube will not stay on the SIP without the tube support arm.
l When the tube is installed and RUN is pressed on the cytometer, the RUN button is orange (not green).

Cytometer hardware might be contaminated with biohazardous material. Wear suitable protective
clothing, eyewear, and gloves whenever cleaning the cytometer or replacing parts.
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Procedure
To replace the Bal seal:
1. Remove the outer sleeve from the sample injection tube by turning the retainer counter-clockwise. Slide the

outer sleeve down and off of the sample injection tube.
Work carefully. The outer sleeve can fall off as you loosen the retainer. See the following illustration.

4

3

2

1

Number Components

1 Bal seal

2 Retainer

3 Outer sleeve

4 Sample injection tube (SIT)

2. Remove the Bal seal by gripping it between your thumb and index finger and pulling down. See the
following illustration.

3. Install the new Bal seal spring-side up.
Ensure that the sample tube O-ring is still in place inside the retainer.

4. Re-install the retainer and outer sleeve over the sample injection tube. Push the outer sleeve all the way up
into the sample injection port and then screw the retainer into place and tighten to finger tight. This will
seat the Bal seal.
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5. Install a sample tube on the SIP to ensure that the outer sleeve has been properly installed.
If the sleeve hits the bottom of the tube, loosen the retainer slightly and push the sleeve up as far as it will
go. Tighten the retainer.

Changing the sample tube O-ring

Introduction
This topic describes how to replace the sample tube O-ring.

The sample tube O-ring, located within the retainer, forms a seal that allows the droplet containment vacuum
to function properly.

When to replace the O-ring
Replace the O-ring when droplets form at the end of the sample injection tube while the vacuum is operating.

Cytometer hardware might be contaminated with biohazardous material. Wear suitable protective
clothing, eyewear, and gloves whenever cleaning the cytometer or replacing parts.

Procedure
To change the O-ring:
1. Remove the outer sleeve from the sample injection tube by turning the retainer counter-clockwise.
2. Slide the outer sleeve from the retainer. See the following illustration.

2

1

Number Components

1 O-ring

2 Retainer

3. Invert the outer droplet sleeve and allow the O-ring to fall onto the benchtop.
If the O-ring does not fall out initially, hold the O-ring with your free hand and slide the outer sleeve to
remove the O-ring.

4. Place the new O-ring into the retainer. Make sure the O-ring is seated properly in the bottom of the retainer.
5. Replace the outer sleeve in the retainer.
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6. Re-install the retainer and the outer sleeve.
7. Install a sample tube on the SIP to ensure that the outer sleeve has been properly installed.

If the sleeve hits the bottom of the tube, loosen the retainer slightly and push the sleeve up as far as it will
go. Tighten the retainer.

Cleaning or replacing the sheath gasket

Introduction
This topic describes how to clean or replace the gasket of the sheath tank lid.

When to change the sheath gasket
We recommend cleaning the sheath gasket when needed.

Procedure
To clean or replace the gasket:
1. Put the cytometer in standby mode.
2. Depressurize the sheath container by pulling up on the vent valve.
3. Remove the lid from the sheath tank.
4. Remove the black gasket from the lid.
5. Rinse it with water to clean the gasket.
6. Place the clean gasket or the new gasket on the lid and make sure the gasket is seated properly on the lid.

Accessing the red laser detector array
This topic describes how to access the red laser detector array for the purpose of checking or changing the
optical filters. The access panel is located on the right-hand side of the cytometer.

To remove the access panel:
1. Locate the red laser detector array access panel on the side of the cytometer, see Cytometer overview (page

15).
2. Remove the thumb screws and set them aside.
3. Place a small stiff object such as a thin screwdriver in one of the thumbscrew holes.
4. Tilt the screwdriver handle close to the cytometer and pull outwards to pop the panel off the cytometer.

To replace the access panel:
1. Position the panel over the the red laser detector array.
2. Push evenly on both sides to pop the panel back onto the cytometer.
3. Screw in the thumbscrews.
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5
5

Optimizing cytometer settings
This chapter covers the following topics:
l Cytometer settings workflow (page 54)
l Verifying the configuration and user preferences (page 55)
l Running a performance check (page 57)
l Setting up an experiment (page 60)
l Creating application settings (page 64)
l Recording compensation controls (page 66)
l Calculating compensation (page 68)
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Cytometer settings workflow

Introduction
This topic describes how to optimize cytometer settings. The optimization is performed using the Cytometer
Setup and Tracking, Application Settings, and Compensation Setup features of BD FACSDiva™ software.

When to optimize settings
Before you record data for a sample, optimize the cytometer settings for the sample type and fluorochromes
used.

Manual compensation
Compensation setup automatically calculates compensation settings. If you choose to perform compensation
manually, not all of the following instructions apply. For detailed instructions, see the BD FACSDiva™ Software
Reference Manual.

First-time users
If you are performing the procedures in this workflow for the first time, you should be familiar with
BD FACSDiva™ software concepts: workspace components, cytometer and acquisition controls, and tools for
data analysis.

For additional details, see the BD FACSDiva Software Reference Manual.

Before you begin
Start the BD FACSymphony™ A1 flow cytometer and perform the setup and QC procedures. See Cytometer
setup (page 27).

Workflow for optimizing settings
Cytometer optimization consists of the following steps.

Step Description

1 Verifying the configuration and user preferences (page 55)

2 Running a performance check (page 57)

3 Setting up an experiment (page 60)

4 Creating application settings (page 64)

5 Recording compensation controls (page 66)

6 Calculating compensation (page 68)

Note: Application settings are optional and do not have to be saved for the experiments. However, they are
useful for optimizing cytometer settings.
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About the examples
The examples in this chapter use a 4-color bead sample with the following fluorochromes:
l FITC
l PE
l PerCP-Cy5.5
l APC

If you follow this workflow with a different bead sample (or another sample type), your software views, data
plots, and statistics might differ from the example. Additionally, you might need to modify some of the
instructions in the procedure.

The information shown in italics is for example only. You can substitute your own names for folders and
experiments.

Verifying the configuration and user preferences

Introduction
This topic describes how to verify the cytometer configuration and user preferences before you create an
experiment.

To obtain accurate data results, the current cytometer configuration must reflect your
BD FACSymphony™ A1 flow cytometer optics.
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Procedure
To verify the configuration and preferences before you create an experiment:
1. Select Cytometer > View Configurations and verify the current configuration.

Your cytometer might include only the base configuration when your cytometer is installed. You can create
additional configurations later as needed.
In this example, the cytometer configuration must include the following parameters: FITC, PE, PerCP-Cy5.5,
and APC.

2. If you need to select a configuration other than the current configuration:
a. In the Configurations tab, select a configuration.
b. Click Set Configuration.
c. Click OK.
d. Verify that the configuration you just set matches your BD FACSymphony™ A1 flow cytometer optics.

3. Click OK to close the Cytometer Configuration window.
4. Select File > Exit to close CS&T.
5. Select Edit > User Preferences.
6. Click the General tab and select the Load data after recording checkbox.

See the BD FACSDiva™ Software Reference Manual for more information about cytometer configurations and
user preferences.
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More information
l Setting up an experiment (page 60)

Running a performance check

Introduction
This topic describes how to run a performance check as part of quality control.

Overview
The CS&T application is designed to monitor performance on a daily basis and to optimize laser delay.

Running a performance check on a regular basis provides a standard for monitoring changes in performance
due to degradation of laser power, aging of PMTs, and other potential cytometer service issues. Performance
results are also affected by fluidics performance. We strongly recommend following the fluidics maintenance
procedures as described in Cleaning the fluidics (page 41).

Considerations
Some BP filters might not be normalized to CS&T settings. In this case, CS&T will generate Qr and Br numbers
that are not comparable from instrument to instrument. They are however, still trackable on one cytometer.
Part of the process for optimizing cytometer settings includes verifying PMT voltages set by CS&T for all
parameters. Carefully examine any channel with a non-CS&T normalized filter. If the baseline settings are not
appropriate for your applications, adjust the PMT voltage as necessary and use the Application Settings to
maintain Target Values.

Before you begin
Define the performance baseline for any configuration before running a performance check. See Custom
configurations and baselines (page 37).

Procedure
To run a performance check:
1. Select Cytometer > CST.
2. Verify that the bead lot information under Setup Beadsmatches the Cytometer Setup and Tracking bead

lot.

3. Verify that the cytometer configuration is correct for your experiment.
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If the cytometer is not set to the correct configuration:
a. Click Select Configuration in the Setup Control window.
b. Select the correct configuration from the list.
c. Click Set Configuration and then click OK.

4. Verify that the current configuration has a valid baseline defined.
If not, see the BD Cytometer Setup and Tracking Application Guide for more information on defining a
baseline.

5. Prepare the CS&T beads according to the technical data sheet provided with the beads or available on the
BD Biosciences website (bdbiosciences.com).

6. Install the bead tube onto the SIP.
7. In the Setup Control window, select Check Performance from the Characterizemenu.

8. Click Run.
9. Ensure that Fine Adjust is set to 250, press RUN, and LOW.

Plots appear under the Setup tab and the performance check is run. The performance check takes
approximately 5 minutes to complete.

10. Once the performance check is complete, click View Report.
11. Verify that the cytometer performance passed.

In the Setup tab, the cytometer performance results should have a green checkbox displayed and the word
Passed next to it.
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If any parameters did not pass, see the BD Cytometer Setup and Tracking Application Guide for
troubleshooting information.

12. Select File > Exit to close the CS&T window and return to the BD FACSDiva™ interface.
The CST Mismatch dialog opens.

Click the Details button to verify which cytometer settings will be updated.
13. Click Use CST Settings.

By selecting Use CST Settings, the laser delay, area scaling, and other cytometer settings will be updated to
the latest settings from the performance check.
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Setting up an experiment

Introduction
This topic describes how to create an experiment in a new folder, specify the parameters of the experiment, and
add compensation tubes.

Creating an experiment
To create an experiment:
1. Click the buttons on theWorkspace toolbar to display the following windows as needed:

l Browser
l Cytometer
l Inspector
l Worksheet
l Acquisition Dashboard
When you add elements or make selections in the Browser, the Inspector displays details, properties, and
options that correspond to your selection.

2. Click the New Folder button on the Browser toolbar to add a new folder.
3. Click the folder and rename itMyFolder.
4. ClickMyFolder, then click the New Experiment button on the Browser toolbar.

a. Click the new experiment in the Browser and rename itMyExperiment.
5. SelectMyExperiment in the Browser.

The Inspector displays details for the experiment.

Specifying parameters
To specify the parameters for the new experiment:
1. Select Cytometer Settings for the experiment in the Browser.

Cytometer settings appear in the Inspector.
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2. Make sure the parameters you need appear on the Parameters tab in the Inspector.
If more than one parameter is available for a particular detector, you might have to select the one you need
from a menu. For example, you can set Detector D for the blue laser as FITC or BB515.

Chapter 5  Optimizing cytometer settings 61

Status: Released EFFECTIVEDocument: 23-23437 Doc Type: ZLU
Change #: 500000344050Revision: 02

Version: BUsage: Production Usage Classification: ConfidentialPrint Date: 22-Apr-2025 22:28:10 GMT Daylight Time
Valid From: 27-Jun-2024 To: 31-Dec-9999 Doc Part: EN



a. Click the Parameter name to display the available fluorochromes in the Parameters list.

b. Select the specific parameter from the menu. Your selection appears as the selected parameter.
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c. For this example, select FITC from the menu.
3. Delete any unnecessary parameters.
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a. Click the selection button (to the left of the parameter name) to select the parameter.

b. Click Delete.
The parameter is deleted.

Creating application settings

Introduction
This topic describes how to create application settings.

About application settings
Application settings are associated with a cytometer configuration and include the parameters for the
application, area scaling values, PMT voltages, and threshold values, but not compensation. Each time a
performance check is run for a configuration, the application settings associated with that configuration are
updated to the latest run.

Using application settings provides a consistent and reproducible way to reuse cytometer settings for
commonly used applications.
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Before you begin
Perform the cytometer setup procedure and run a performance check for the configuration that will be used for
the application.

Procedure
To create application settings:
1. In the open experiment, right-click Cytometer Settings in the Browser, then select Application Settings >

Create Worksheet.
A second global worksheet is added with the plots created according to the selections in the Parameters tab.

2. Load the unstained control tube onto the cytometer.
3. In the Cytometer window, optimize the PMT voltages for the application.

l Optimize the FSC and SSC voltages to place the population of interest on scale.
l Optimize the FSC threshold value to eliminate debris without interfering with the population of interest.
l If needed, increase the fluorescence PMT voltages to place the negative population appropriately for

your sample type.
4. Unload the unstained control tube from the cytometer.
5. Load the multicolor sample onto the cytometer or load single-color control tubes and verify each

fluorochrome signal separately.
6. Verify that the positive populations are on scale.

If a positive population is off scale, lower the PMT voltage for that parameter until the positive population
can be seen entirely on scale.

7. Unload the multicolor sample.
8. Place a tube containing less than 1 mL DI water on the SIP and put the cytometer on standby.
9. (Optional) Save the application settings by right-clicking Cytometer settings in the Browser, then selecting

Application Settings > Save.
10. In the Save Application Settings dialog, enter a descriptive name for the application settings.
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11. Click OK.
The application settings are saved to the catalog.

Recording compensation controls

Introduction
This topic describes how to create and record compensation controls using the Compensation Setup feature of
BD FACSDiva™ software and an experiment with optimized settings.

Creating compensation tubes
To create compensation control tubes:
1. Select Experiment > Compensation Setup > Create Compensation Controls.

The Create Compensation Controls dialog opens.
For this bead example, you do not need to provide non-generic tube labels.

2. Click OK.

Compensation control tubes are added to the experiment. Worksheets containing appropriate plots and
gates are added for each compensation tube.
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Recording compensation settings
To record compensation settings:
1. Press RUN and HIGH on the cytometer fluid control panel.
2. Install the unstained control tube onto the SIP.
3. Expand the Compensation Controls specimen in the Browser.
4. Set the current tube pointer to the unstained control tube (it becomes green), then click Acquire Data in the

Acquisition Dashboard.
5. Verify that the population of interest is displayed appropriately on the FSC vs SSC plot and adjust voltages if

necessary.

Since the application settings have been optimized for your sample, the cytometer settings should not
require adjustment other than the changing of FSC and SSC voltages to place the beads on scale.

6. Adjust the P1 gate to surround only the singlets.
7. Right-click the P1 gate and select Apply to All Compensation Controls.

The P1 gate on each stained control worksheet is updated with your changes.
8. Click Record Data.
9. When recording is finished, remove the unstained control tube from the cytometer.

10. Click Next Tube.

Do not change the PMT voltages after the first compensation control has been recorded. In
order to calculate compensation, all controls must be recorded with the same PMT voltage
settings. If you need to adjust the PMT voltage for a subsequent compensation control, you
must record all compensation controls again.

11. Install the next tube onto the cytometer and repeat steps 8 through 10 until data for all stained control
tubes has been recorded.

12. Double-click the first stained control tube to display the corresponding worksheet.
13. Verify that the snap-to interval gate encompasses the positive population.
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14. Repeat steps 12 and 13 for the remaining compensation tubes.

Next step
After you have recorded data for each single-stained control, calculate compensation as described in
Calculating compensation (page 68).

Calculating compensation

Introduction
This topic describes how to calculate compensation.

Before you begin
Before you can calculate compensation, you need to record the data for each single-stained control.

Procedure
To calculate compensation:
1. Select Experiment > Compensation Setup > Calculate Compensation.

Note: If the calculation is successful, a dialog prompts you to enter a name for the compensation setup. The
default name is year/month/day/time.

2. Enter a setup name and click Link & Save.
The compensation is linked to the cytometer settings and saved to the catalog.
To help track compensation setups, include the experiment name, date, or both in the setup name.
The compensation setup is linked to theMyExperiment cytometer settings, and subsequent acquisitions in
MyExperiment are performed with the new compensation settings.

We recommend that you always visually and statistically inspect automatically calculated spectral overlap
values. The medians of the positive controls should be aligned with the medians of the negative controls.

More information
l Recording compensation controls (page 66)
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6
6

Recording and analyzing data
This chapter covers the following topics:
l Data recording and analysis workflow (page 70)
l Preparing the workspace (page 70)
l Recording data (page 71)
l Analyzing data (page 73)
l Reusing an analysis (page 77)
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Data recording and analysis workflow

Introduction
This topic outlines the basic acquisition and analysis tasks using BD FACSDiva™ software.

About the examples
The examples in this chapterare from two 4-color bead samples with the following fluorochromes:
l FITC
l PE
l PerCP-Cy5.5
l APC

If you use a different sample type or if you have skipped the optimization steps in Optimizing cytometer
settings (page 53), your software window content, names of folders and experiments, and your data plots and
statistics might differ from those shown here. You might also need to modify some of the instructions in the
procedure.

For additional details on completing some of the following steps, see the BD FACSDiva™ Software Reference
Manual.

Workflow for recording and analyzing data
Recording and analyzing data consists of the following steps.

Step Description

1 Preparing the workspace (page 70)

2 Recording data (page 71)

3 Analyzing data (page 73)

4 Reusing an analysis (page 77)

Preparing the workspace

Introduction
This topic describes how to prepare the workspace and apply application settings to your experiment before
recording data.

Procedure
To prepare the workspace:
1. Using the Browser toolbar, create a new specimen inMyExperiment and rename it FourColorBeads.
2. Create two tubes for the FourColorBeads specimen. Rename the tubes Beads_001 and Beads_002.
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3. Expand the Global Worksheets folder inMyExperiment to access the default global worksheet, and rename
the worksheetMyData.

4. On theMyData worksheet, create the following plots for previewing the data:
l FSC vs SSC
l FITC vs PE
l FITC vs PerCP-Cy5.5
l FITC vs APC

Applying saved application settings to a new experiment
When applications settings are applied to an experiment, the cytometer settings are updated with the
parameters included in the application settings, optimized PMT voltages, threshold settings, area scaling
factors, and window extension values.

To apply saved application settings to your experiment:
1. Right-click the experiment-level Cytometer Settings and select Application Settings > Apply.
2. In the Application Settings catalog, select the application settings file you saved previously and click Apply.

If the parameters are not the same, a mismatch dialog opens.
l Click Overwrite to update all settings.
l Click Apply to change only the common parameters.
For more information, see the BD FACSDiva™ Software Reference Manual.

The cytometer settings are renamed application settings and the cytometer settings icon in the Browser
changes.

More information
l Creating application settings (page 64)
l Recording data (page 71)

Recording data

Introduction
This topic provides an example of how to preview and record data for multiple samples.

Before you begin
Prepare the sample tubes.

Note: If you need to run samples at an event rate greater than 10,000 events/second, consider changing your
Window extension. See the BD FACSDiva™ Software Reference Manual for more information.

Recording data
To record data:
1. Press RUN and HIGH on the cytometer fluid control panel.
2. Install the first sample tube onto the SIP.
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3. Set the current tube pointer to Beads_001.
4. Click Acquire Data in the Acquisition Dashboard to begin acquisition.
5. While data is being acquired:

a. Draw a gate around the singlets on the FSC vs SSC plot.
b. Rename the P1 gate to Singlets.
c. Use the Inspector to set the other plots to show only the singlet population by selecting the Singlets

checkbox.

6. Click Record Data.
7. When event recording has completed, remove the first tube from the cytometer.

TheMyData worksheet plots should look like the following.

8. Install the second sample tube onto the SIP.
9. Set the current tube pointer to Beads_002.

10. Click Acquire Data to begin acquisition.
11. Before recording, preview the data on theMyData worksheet to verify that all expected populations are

visible and the data is similar to the previous sample.
12. Click Record Data.
13. When event recording has completed, remove the second tube from the cytometer.
14. If you are recording more than two tubes, repeat steps 8 through 13 for the remaining tubes.
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15. Print the experiment-level cytometer settings by right-clicking the Cytometer Settings icon in the Browser
and selecting Print.

16. Install a tube with less than 1 mL of DI water onto the SIP.
17. Place the cytometer in standby mode.

Analyzing data

Introduction
This topic describes how to analyze recorded tubes by creating plots, gates, a population hierarchy, and
statistics views on a new global worksheet.

Analyzing data
To analyze data:
1. Use the Browser toolbar to create a new global worksheet. Rename itMyDataAnalysis.
2. Create the following plots on theMyDataAnalysis worksheet:

l FSC vs SSC
l FITC vs PE
l FITC vs PerCP-Cy5.5
l FITC vs APC

3. Create a population hierarchy and a statistics view, and set them below the plots on the worksheet.
l Right-click any plot and select Show Population Hierarchy.
l Right-click any plot and select Create Statistics View.

4. Set the current tube pointer to Beads_001.
5. Draw a gate around the singlets on the FSC vs SSC plot.
6. Use the population hierarchy to rename the population Singlets.
7. Select all plots except the FSC vs SSC plot, and use the Plot tab in the Inspector to specify to show only the

singlet population.
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8. Select all plots, and click the Title tab in the Inspector.
9. Select the Tube and Populations checkboxes to display their names in plot titles.

10. On all fluorescence plots:
l Make all plots biexponential. Select all fluorescence plots and select the X Axis and Y Axis checkboxes in

the Plot tab of the Inspector.

74 BD FACSymphony™ A1 Flow Cytometer User's Guide

Status: Released EFFECTIVEDocument: 23-23437 Doc Type: ZLU
Change #: 500000344050Revision: 02

Version: BUsage: Production Usage Classification: ConfidentialPrint Date: 22-Apr-2025 22:28:10 GMT Daylight Time
Valid From: 27-Jun-2024 To: 31-Dec-9999 Doc Part: EN



l In the FITC vs PE plot, draw a gate around the FITC-positive population. Name the population FITC
positive in the population hierarchy.

l In the FITC vs PE plot, draw a gate around the PE-positive population. Name the population PE positive in
the population hierarchy.

l In the FITC vs PerCP-Cy5.5 plot, draw a gate around the PerCP-Cy5.5-positive population. Name the
population PerCP-Cy5.5 positive in the population hierarchy.

l In the FITC vs APC plot, draw a gate around the APC-positive population. Name the population APC
positive in the population hierarchy.

11. Format the statistics view.
a. Right-click the statistics view and select Edit Statistics View.
b. Click the Header tab and select the Specimen Name and Tube Name checkboxes.
c. Click the Populations tab and select all populations except All Events. Clear the%Parent,%Total, and

#Events checkboxes.
d. Click the Statistics tab and select the mean for each of the fluorescence parameters.

e. Click OK.
12. Print the analysis.
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Your global worksheet analysis objects should look like the following.
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Reusing an analysis

Introduction
This topic describes how to use a global worksheets to apply the same analysis to a series of recorded tubes.
Once you define an analysis for a tube, you can use it to analyze the remaining tubes in the experiment. After
viewing the data, print the analysis or save it to a normal worksheet.

Reusing an analysis
To reuse the analysis:
1. Set the current tube pointer to the Beads_002 tube.
2. View the Beads_002 data on your analysis worksheet. Adjust the gates as needed.

Adjustments apply to subsequent tubes viewed on the worksheet. To avoid altering a global worksheet, save
an analysis to a normal worksheet, then make adjustments on the normal worksheet.

3. Print the analysis.

Saving the analysis
When you perform analysis with a global worksheet, the analysis does not save with the tube.

If you define your analysis on a global worksheet before recording data, you can specify to automatically save
the analysis after recording data. You set this option in User Preferences.

To save a copy of the analysis with a tube:
1. Expand theMyDataAnalysis global worksheet icon in the Browser.
2. Right-click its analysis and select Copy.

3. Click theWorksheets View button on theWorksheet toolbar to switch to the normal worksheet view.
4. SelectWorksheet > New Worksheet to create a new normal worksheet.
5. Right-click the Beads_001 tube icon in the Browser, and select Paste.

The analysis objects from theMyDataAnalysis global worksheet are copied to the Beads_001_Analysis
normal worksheet. Double-click the Beads_001 tube in the Browser to view the analysis.

Chapter 6  Recording and analyzing data 77

Status: Released EFFECTIVEDocument: 23-23437 Doc Type: ZLU
Change #: 500000344050Revision: 02

Version: BUsage: Production Usage Classification: ConfidentialPrint Date: 22-Apr-2025 22:28:10 GMT Daylight Time
Valid From: 27-Jun-2024 To: 31-Dec-9999 Doc Part: EN



Applying an analysis to normal worksheets
You can apply the global worksheet analysis to multiple tubes (on a single normal worksheet) by selecting
multiple tubes before pasting the analysis. Ensure that you collapse all tube elements in the Browser before you
paste them to multiple tubes.

More information
l Analyzing data (page 73)
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7
7

Technical overview
This chapterprovides a technical overview of the following topics:
l About fluidics (page 80)
l About optics (page 81)
l About electronics (page 86)
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About fluidics

Introduction
This topic describes the BD FACSymphony™ A1 flow cytometer fluidics system.

Pressure-driven fluidics system
The fluidics system in the BD FACSymphony™ A1 flow cytometer operates at a pressure of 5.5 psi. After passing
through the sheath filter, sheath fluid is introduced into the lower chamber of the quartz flow cell.

Hydrodynamic focusing
The sample to be analyzed arrives in a separate pressurized stream. When a sample tube is placed on the SIP,
the sample is forced up and injected into the lower chamber of the flow cell by a slight overpressure relative to
the sheath fluid. The conical shape of the lower chamber creates a laminar sheath flow that carries the sample
core upward through the center of the flow cell, where the particles to be measured are intercepted by the laser
beam. This process is known as hydrodynamic focusing.

Low sample 

pressure

(12 μL/min)

Sheath fluid

Sample

Sheath fluid Sheath fluid

Sample

Sheath fluid

Laser beam Laser beam

High sample

pressure

(60 μL/min)

The objective in flow cytometric analysis is to have at most one cell or particle moving through a laser beam at
a given time. The difference in pressure between the sample stream and sheath fluid stream can be used to
vary the diameter of the sample core.

Changing the sample flow rate changes the sample pressure thereby changing the core diameter. The flow rate
should be set according to the type of application you are running.
l A higher flow rate is generally used for qualitative measurements such as immunophenotyping. The data is

less resolved, but is acquired more quickly.
l A lower flow rate is generally used in applications where greater resolution and quantitative measurements

are critical, such as DNA analysis.

Proper operation of fluidic components is critical for particles to intercept the laser beam properly. Always
ensure that the fluidics system is free of air bubbles and debris, and is properly pressurized.
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About optics

Introduction
This topic describes the optics system and provides information about:
l Light scatter (page 81)
l Fluorescence (page 81)
l Optical filter theory (page 82)
l Compensation theory (page 85)

Optics system
The optics system consists of lasers, optical filters, and detectors. Lasers illuminate the cells or particles in the
sample and optical filters direct the resulting light scatter and fluorescence signals to the appropriate detectors.

Light scatter
When a cell or particle passes through a focused laser beam, laser light is scattered in all directions. Light that
scatters axial to the laser beam is called forward scatter (FSC) and light that scatters perpendicular to the laser
beam is called side scatter (SSC).

FSC and SSC are related to certain physical properties of cells.
l FSC Indicates relative differences in the size of the cells or particles. Larger cells scatter more light and

therefore they are higher in FSC.
l SSC Indicates relative differences in the internal complexity or granularity of the cells or particles. More

granular cells deflect more light than less granular cells, and therefore are higher in SSC.

Fluorescence
When cells or particles stained with fluorochrome-conjugated antibodies or other dyes pass through a laser
beam, the dyes can absorb photons (energy) and be promoted to an excited electronic state. In returning to
their ground state, the dyes release energy, most of which is emitted as light. This light emission is known as
fluorescence.

Fluorescence is always a longer wavelength (lower-energy photon) than the excitation wavelength. The
difference between the excitation wavelength and the emission wavelength is known as the Stokes shift. Some
fluorescent compounds such as PerCP exhibit a large Stokes shift, absorbing blue light (488 nm) and emitting
red light (675 nm), while other fluorochromes such as FITC have a smaller Stokes shift, absorbing blue light
(488 nm) and emitting green light (530 nm).

Actual emission intensity will depend on excitation wavelength. See Fluorescence spectra (page 100) for more
information on excitation and emission of fluorochromes. An interactive spectrum viewer is also available at
bdbiosciences.com.
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Optical filter theory
Optical filters modify the spectral distribution of light scatter and fluorescence directed to the detectors. When
photons encounter an optical filter, they are either transmitted, absorbed, or reflected.

Photons

Transmitted

Photons

absorbed
Photons

reflected

Even though an optical filter is rated at its 50% transmission point, the filter passes (lets through) a minimal
amount of light outside of this indicated rating.

The slope of an optical filter transmission curve indicates filter performance. A relatively steep slope indicates a
high-performance, high-quality optical filter that provides deep attenuation of out-of-band wavelengths. A less
steep slope indicates that more light outside the rated bandwidth is being transmitted.

Types of optical filters
There are four types of filters.
l Longpass (LP) filters Transmit wavelengths at or longer than the specified value.
l Shortpass (SP) filters Transmit wavelengths at or shorter than the specified value. This type of filter is not

recommended.
l Bandpass (BP) filters Pass a narrow spectral band of light by combining the characteristics of shortpass

filters, longpass filters, and absorbing layers.
l Notch filters Pass all frequencies except those in a stop band centered on a center frequency. They are the

opposite of bandpass filters.

The BD FACSymphony™ A1 uses LP filters and BP filters.
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Longpass (LP) filters
LP filters pass wavelengths longer than the filter rating. For example, a 500-LP filter permits wavelengths 500
nm or longer to pass through it and either absorbs or reflects wavelengths shorter than 500 nm.

Shortpass (SP) filters
An SP filter has the opposite properties of an LP filter. An SP filter passes light with a shorter wavelength than
the filter rating. For example, a 500-SP filter passes wavelengths of 500 nm or shorter, and reflects or absorbs
wavelengths longer than 500 nm.
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Bandpass (BP) filters
A BP filter transmits a relatively narrow range or band of light. BP filters are typically designated by two
numbers. The first number indicates the center wavelength and the second refers to the width of the band of
light that is passed. For example, a 500/50-BP filter transmits light that is centered at 500 nm and has a total
bandwidth of 50 nm. Therefore, this filter transmits light between 475 and 525 nm.

The performance of an optical BP filter depends on the optical transmission. Sample transmission curves are
shown in the following figure. A filter with a narrower (steeper) transmission curve generally yields higher
performance. The transmission specifications depend on the construction of the filter.

Dichroic mirrors
Dichroic filters that are used to direct different color light signals to different detectors are called dichroic
mirrors.

Although some of the properties of LP and SP filters are similar to dichroic mirrors (for example, allowing a
specific wavelength range to pass), filters and mirrors cannot be used interchangeably, especially if used as
dichroic mirrors. A dichroic mirror must have a surface coating that reflects certain wavelengths, but many LP or
SP filters are absorbance filters that do not have any specific reflective characteristics. Also, optical filters and
dichroic mirrors are rated at a specific angle of incidence. When used in front of the fluorescence detectors,
they are perpendicular to the incident light, and when used as a dichroic mirror, they are placed at an angle
relative to the light source. Their optical properties are therefore designed for that angle of incidence.
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Reflective mirrors
Reflective mirrors reflect all light in their performance band. They are intended to pass light to the next optic
with minimal loss regardless of wavelength. These are used when a detector position needs to be bypassed due
to space constraints.

Compensation theory
Fluorochromes emit light over a range of wavelengths. Optical filters are used to limit the range of frequencies
measured by a given detector. However, when two or more fluorochromes are used, the overlap in wavelength
ranges often makes it impossible for optical filters to isolate light from a given fluorochrome. As a result, light
emitted from one fluorochrome appears in a detector intended for another. This is referred to as spillover.
Spillover can be corrected mathematically by using a method called compensation.

In the following example, FITC emission appears primarily in the FITC detector, but some of its fluorescence
spills over into the PE detector. The spillover must be corrected or compensated for. Alternatively, the spillover
can be minimized by discrete excitation of fluorochromes. In the following example, excitation with a yellow-
green configuration will help minimize spillover.

This spillover can be seen in a dot plot of FITC vs PE. The FITC spillover in the PE detector must be corrected as
demonstrated in the two figures that follow.

Using the Compensation tab of the Cytometer window in BD FACSDiva™ software, you can adjust the
PE-%FITC spectral overlap value. Compensation is optimal when the positive and negative FITC populations
have the same medians in the PE parameter statistics.
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The following image shows the FITC spillover optimally compensated out of the PE parameter.

Once fluorescence compensation has been set for any sample, the compensation setting remains valid for a
subsequent dim or bright sample (provided the signal is not saturated), because compensation subtracts a
percentage of the fluorescence intensity. The following figure illustrates this principle. Although the signals
differ in intensity, the percentage of the FITC spillover into the PE detector remains constant.

About electronics

Introduction
This topic describes the electronics in the BD FACSymphony™ A1 flow cytometer.

Pulse
As cells or other particles pass through a focused laser beam, they scatter the laser light and can emit
fluorescence. Because the laser beam is focused on a small spot and particles move rapidly through the flow
cell, the scatter or fluorescence emission signal has a very brief duration—only a few microseconds. This brief
flash of light is converted into an electrical signal by the detectors. The electrical signal is called a pulse. The
following figures illustrate the anatomy of a pulse.
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1. A pulse begins when a particle enters the laser beam. At this point, both the beam intensity and signal
intensity are low.

2. The pulse reaches a maximum intensity or height when the particle reaches the middle of the beam, where
the beam and signal intensity are the brightest. The peak intensity, or height of the pulse, is measured at
this point.

3. As the particle leaves the beam, the pulse trails off below the threshold.

Pulse measurements
The pulse processors measure pulses by three characteristics: height, area, and width.

l Height The maximum digitized intensity measured for the pulse.
l Area The integration of all the digitized samples over time, where time is the window gate plus 1/2 the

window extension added before the initial threshold, plus the other half of the window extension value
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added after the pulse drops below the threshold. The window gate extends until the pulse is 75% of the
initial threshold.

l Width The current width is measured by the electronics.

Digital electronics
BD FACSymphony™ A1 electronics digitize the signal intensity produced by a detector. The digitized data is
stored in memory and further processed by the electronics to calculate:
l Pulse height and area
l Compensation
l Parameter ratios

These results are transferred to your workstation computer for further processing by BD FACSDiva™ software.
For more information about digital theory, see Digital Theory in the BD FACSDiva™ Software Reference Manual.

Threshold
The threshold is the level at which the system starts to measure signal pulses. A threshold is defined for a
specific detector signal. The system continuously samples the digitized signal data and calculates pulse area
and height for all channels based on the time interval during which the threshold is exceeded.

Thresholds can also be set for more than one parameter, and pulse measures are based on either of the
following:
l Intervals during which ALL signals exceed their threshold value (AND threshold in the software)
l Intervals during which ANY signal exceeds its threshold value (OR threshold in the software)

Laser controls
Controls in the Laser tab of the Cytometer window are used to manually set the (laser) delay, area scaling, and
window extension values.

These parameters are set by BD Biosciences service personnel during instrument installation and performance
check and are updated each time you run a performance check.

Note: Do not otherwise change the settings in the Laser tab unless instructed to do so by BD Biosciences.
Changing the settings affects your data.

See the following screen capture for the correct settings.
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More information
l Running a performance check (page 57)
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8
8

Troubleshooting
This chapter covers the following topics:
l Cytometer troubleshooting (page 92)
l Electronics troubleshooting (page 97)
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Cytometer troubleshooting

Introduction
This topic describes possible problems and recommended solutions for BD FACSymphony™ A1 flow cytometer
issues.

Droplets are visible on the SIT

Possible causes Recommended solutions

Worn O-ring in the retainer Replace the O-ring. See Changing the sample tube O-ring (page 50).

Outer sleeve is not seated in
the retainer

1. Loosen the retainer.

2. Push the outer sleeve up into the retainer until seated.

3. Tighten the retainer.

Outer sleeve is not on the
sample injection tube

Replace the outer sleeve.

1. Loosen the retainer.

2. Slide the outer sleeve over the sample injection tube until it is seated.

3. Tighten the retainer.

Waste line is pinched,
preventing proper aspiration

Check the waste line.

Waste tank is full Empty the waste tank.

Droplet containment vacuum
is not functioning

Call your BD service representative.

Acquisition Mode switch set
to Plate

Make sure Acquisition Mode switch is set to Tube when HTS is not attached.

The mode is not set to HTS. Change the mode to HTS by pressing down the MODE button for more than 3 seconds.

Sample tube not fitting on SIP

Possible causes Recommended solutions

Sample tube other than
Falcon® tubes used

Use Falcon® 12 x 75-mm polystyrene sample tubes. See Equipment (page 121).

Worn Bal seal Replace the Bal seal. See Changing the Bal seal (page 48).

Sample tube is cracked Transfer contents to a new tube.

Rapid sample aspiration

Possible causes Recommended solutions

Support arm is to the side Place the support arm under the sample tube.
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Possible causes Recommended solutions

Droplet containment module
is failing

Try the solutions in Droplets are visible on the SIT (page 92). If the issue is not resolved,
call your BD service representative.

No events in acquisition display and RUN button is green

Possible causes Recommended solutions

Threshold is not set to the
correct parameter (usually
FSC)

Set the threshold to the correct parameter for your application.

Threshold level is too high Lower the threshold level.

PMT voltage for threshold
parameter is set too low

Set the PMT voltage higher for the threshold parameter.

Gating issue See the BD FACSDiva™ Software Reference Manual for information on setting gates.

Air in the sheath filter Purge the filter. See Removing air bubbles (page 31).

Air bubble or debris in the
flow cell

Prime the fluidics system. See Preparing the fluidics (page 34).

No sample in the tube Verify that sample remains in the tube and if necessary, add sample to the tube or install
a new sample tube.

Sample is not mixed properly Mix the sample to suspend the cells.

Waste tank is full Empty the waste tank.

PMT voltages set too low or
too high for display
parameter

Adjust the PMT voltages.

Too few events are displayed Increase the number of events to display.

Sample injection tube is
clogged

Remove the sample tube to allow backflushing.

If the event rate is still erratic, clean the sample injection tube. See Cleaning the fluidics
(page 41).

Bal seal is worn Replace the Bal seal. See Changing the Bal seal (page 48).

Instrument is not warmed up Wait 30 minutes for the instrument to warm up.

Laser is not functioning Verify the malfunction by changing the threshold to an alternative laser while running the
appropriate sample. If unsuccessful, contact BD Biosciences.

Tube is cracked or misshapen Replace the sample tube.

Waste tank is pressurized. Disconnect the waste container for at least 30 seconds to allow
the pressure to dissipate.
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No events in acquisition display and RUN button is orange

Possible causes Recommended solutions

RUN is not activated Press the RUN button.

Sample tube is not installed
or is not properly seated

Install the sample tube correctly on the SIP.

Sample tube is cracked Replace the sample tube.

Waste tubing line is
disconnected from the waste
container tank

Connect the waste tubing line to the waste container tank.

Sheath container is not
pressurized

l Ensure that the sheath container lid and all connectors are securely seated.
l Inspect the sheath container O-ring inside the lid and replace it if necessary. See

Cleaning or replacing the sheath gasket (page 51).

Bal seal is worn Replace the Bal seal. See Changing the Bal seal (page 48).

Air leak at sheath container Ensure that the sheath container lid and all connectors are securely seated.

Sheath container is empty Fill the sheath container.

Air in sheath filter Purge the filter. See Removing air bubbles (page 31).

No fluorescence signal

Possible causes Recommended solutions

Incorrect fluorochrome
assignment

Make sure that the cytometer configuration in the software matches the optical filters in
the cytometer and the configuration is as expected.

Laser is not functioning Call your BD service representative.

No signal in red laser channels (when red laser is installed)

Possible causes Recommended solutions

Incorrect laser delays due to
a change in the sheath tank
fluid level

l Check the fluid level in the sheath tank and refill if necessary.

High event rate

Possible causes Recommended solutions

Air bubbles in the sheath
filter or flow cell

Remove the air bubbles. See Removing air bubbles (page 31).

Threshold level is too low Increase the threshold level. See the BD FACSDiva™ Software Reference Manual for
instructions.
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Possible causes Recommended solutions

PMT voltage for the
threshold parameter is set
too high

Set the PMT voltage lower for the threshold parameter.

Sample is too concentrated Dilute the sample.

Sample flow rate is set to
HIGH

Set the sample flow rate to MED or LOW.

Low event rate

Possible causes Recommended solutions

Threshold level is too high Lower the threshold level. See the BD FACSDiva™ Software Reference Manual for
instructions.

Air bubble or debris in the
flow cell

Prime the fluidics system. See Preparing the fluidics (page 34).

PMT voltage for the
threshold parameter is set
too low

Set the PMT voltage higher for the threshold parameter. See the BD FACSDiva™ Software
Reference Manual for instructions.

Sample is not adequately
mixed

Mix the sample to suspend the cells.

Sample is too diluted Concentrate the sample. If the flow rate setting is not critical to the application, set the
flow rate switch to MED or HIGH.

Sample injection tube is
clogged

Remove the sample tube to allow backflushing.

If the event rate is still erratic, clean the sample injection tube. See Cleaning the fluidics
(page 41).

Erratic event rate

Possible causes Recommended solutions

Sample tube is cracked Replace the sample tube.

Air bubble or debris in the
flow cell

Prime the fluidics system. See Preparing the fluidics (page 34).

Bal seal is worn Replace the Bal seal. See Changing the Bal seal (page 48).

Sample injection tube is
clogged

Remove the sample tube to allow backflushing.

If the event rate is still erratic, clean the sample injection tube. See Cleaning the fluidics
(page 41).

Contaminated sample Prepare the specimen again. Ensure that the tube is clean.

Sheath filter is dirty Replace the filter. See Changing the sheath filter (page 45).

Chapter 8  Troubleshooting 95

Status: Released EFFECTIVEDocument: 23-23437 Doc Type: ZLU
Change #: 500000344050Revision: 02

Version: BUsage: Production Usage Classification: ConfidentialPrint Date: 22-Apr-2025 22:28:10 GMT Daylight Time
Valid From: 27-Jun-2024 To: 31-Dec-9999 Doc Part: EN



Distorted scatter parameters

Possible causes Recommended solutions

Cytometer settings are
improperly adjusted

Optimize the scatter parameters. See the BD FACSDiva™ Software Reference Manual for
instructions.

Air bubble in the sheath filter
or flow cell

Purge the air from the filter. See Removing air bubbles (page 31).

Flow cell is dirty Flush the system. See Flushing the system (page 42).

Air leak at sheath container Ensure that the sheath container lid is tight and all connectors are secure.

Hypertonic buffers or fixative Replace the buffers or fixative.

Excessive amount of debris in display

Possible causes Recommended solutions

Threshold level is too low Increase the threshold level.

Sheath filter is dirty Replace the filter. See Changing the sheath filter (page 45).

Flow cell is dirty Flush the system. See Flushing the system (page 42).

Dead cells or debris in the
sample

Examine the sample under a microscope.

Sample is contaminated Re-stain the sample. Ensure that the tube is clean.

Stock sheath fluid is
contaminated

Rinse the sheath container with DI water, then fill the container with sheath fluid from
another (or new lot) bulk container.

High CV or poor QC results

Possible causes Recommended solutions

Air bubble in sheath filter or
flow cell

l Purge the filter. See Removing air bubbles (page 31).
l Prime the fluidics system. See Preparing the fluidics (page 34).

Sample flow rate is set too
high

Set the sample flow rate lower.

Air leak at sheath container Ensure that the sheath container lid is tight and all connectors are secure.

Flow cell is dirty Flush the system. See Flushing the system (page 42).

Waste tank is pressurized Replace the waste container cap. See Replacing the waste tank cap (page 44).

Poor sample preparation Repeat sample preparation.

Sample was not diluted in the
same fluid as the sheath fluid

Dilute the sample in the same fluid as you are using for sheath.

Old or contaminated QC
particles

Make new QC samples and perform the quality control procedure again.
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Possible causes Recommended solutions

Instrument is not warmed up Wait 30 minutes for the instrument to warm up.

Laser is not functioning Contact BD Biosciences.

Optical alignment problem Contact BD Biosciences.

Electronics troubleshooting

Introduction
This topic describes possible problems and recommended solutions for BD FACSymphony™ A1 electronics
issues.

“Cytometer Disconnected” in cytometer window

Possible causes Recommended solutions

Cytometer power is off Turn on the cytometer main power.

Communication failure between
workstation and cytometer

1. In BD FACSDiva™ software, select Cytometer > Connect.

2. If connecting does not work, restart the cytometer. Turn the cytometer off,
wait 1 minute, and turn on the cytometer main power.

3. If connecting still does not work, contact BD Biosciences.
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9
9

Detector array configurations
This chapter covers the following topics:
l Fluorescence spectra (page 100)
l About configuration maps (page 101)
l About configurations (page 102)
l Base configuration polygon maps (page 103)
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Fluorescence spectra

Introduction
This topic shows sample emission spectra from common fluorochromes, as well as the more common laser
excitation lines. This information is useful for designing multicolor panels. An interactive fluorescence viewer is
available at bdbiosciences.com. You can also look for training by selecting Support > Training.

Designing multicolor panels
The BD FACSymphony™ A1 flow cytometer is designed specifically for multicolor research. Results depend on
the excitation and emission spectra of the individual dye, the number of fluorescently labeled binding sites on
the cell, as well as spectral overlap and spillover to other detectors. For more information about designing
multicolor panels, see Selecting Reagents for Multicolor Flow Cytometry (Part No. 23-9538-02).

Example laser and dye interactions
The following figures show the emission spectra of some common dyes, based on laser excitation. In many
cases, a given dye can be excited by multiple laser wavelengths, yielding different emission intensities.

1

2
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3

4

No Definition

1 Violet (405 nm)

2 Blue (488 nm)

3 Yellow-Green (561 nm)

4 Red (637 nm)

About configuration maps

Filter and mirror arrangement
The filters are arranged in the detector array to steer progressively shorter wavelengths of light to the next
detector in the array. The longest wavelength should be in the A position and the shortest wavelength should
be in the last position used.

There should not be any empty slots for any laser being used. Always use a blank optic holder.

If a slot is filled with a filter or mirror, an identifying number appears in that position on the configuration map.
If a slot is filled with a blank optic holder, that position on the configuration map is unlabeled.
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About configurations

Available configurations
The configurations for the BD FACSymphony™ A1 flow cytometer supports detectors, filters, and mirrors for
four lasers to provide either 14 or 16 colors. The Small Particle Detector can be added to either the 14 or 16
color configuration.

Colors Configuration Small Particle
Detector

14 2-Blue 2-Red 4-Yellow-green 6-Violet No

14 2-Blue 2-Red 4-Yellow-green 6-Violet SP Yes

16 2-Blue 3-Red 5-Yellow-green 6-Violet No

16 2-Blue 3-Red 5-Yellow-green 6-Violet SP Yes

Base configuration
The BD FACSymphony™ A1 flow cytometer has one base configuration at installation. The following image
shows a default base cytometer configuration.

More information
l Verifying the configuration and user preferences (page 55)
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Base configuration polygon maps

About the maps
The tables and maps in this section show the detectors, filters, and mirrors used for each laser, and
recommended fluorochromes for each detector. A dash (—) indicates that no slot exists for a mirror in that
detector position.

Six-color violet laser configuration
The following table and map show the six-color configuration for the 405-nm violet laser. The optional 431/28
BP filter can be found in the accessory kit.

Laser Detector LP mirror BP filter Fluorochromes

Violet

405 nm

A 750 780/60 BD Horizon™ BV786

B 690 710/50 BD Horizon™ BV711

C 655 670/30 BD Horizon™ BV650

D 595 610/20 BD Horizon™ BV605

E 505 525/50 BD Horizon™ BV480

F 410 450/50 BD Horizon™ BV421,
BD Horizon™ BV450, Pacific
Blue™

F 410 Optional: 431/28
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Two-color blue laser configuration
The following table and map show the two-color configuration for the 488-nm blue laser.

Note: Detector F is used only when the optional Small Particle Dectector installed.

Note: Because there are no fluorochromes associated with detectors A and D, the configuration displayed by
BD FACSDiva™ does not indicate the existence of mirrors for these detectors, but mirrors are installed during
manufacture to direct the laser beam along the path A-B-C-D-E/F.

Laser Detector Mirror BP filter Fluorochromes

Blue

488 nm

A 595/255R – –

B 690LP 710/50 BD Horizon™ BB700, PerCP-
Cy5.5, 7-AAD

C 505LP 530/30 BD Horizon™ BB515, Alexa
Fluor™ 488, FITC

D 595/255R – –

E _ 488/10 SSC

F* _ 488/10 SP SSC
Only when SPD installed

* Not physically located in polygon but treated as the detector for SP SSC by BD FACSDiva™ software.

Configuration displayed by BD FACSDiva™ software
Physical configuration showing mirrors in detectors with
no fluorochrome
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Five-color yellow-green laser configuration
The following table and map shows the five-color configuration for the 561-nm yellow-green laser.

Note: Detector C is not used in the 14-color configuration.

Laser Detector LP mirror BP filter Fluorochromes

Yellow-Green

561 nm

A 750 780/60 PE-Cy7

B 690 710/50 PE-Cy5.5

C 655 670/30 PE-Cy5

D 595 610/20 BD Horizon™ PE-CF594, PE-
Texas Red, PI

E 580 586/15 PE
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Three-color red laser configuration
The following table and map shows the three-color configuration for the 637-nm red laser.

Note: Detector B is not used in the 14-color configuration.

Laser Detector LP mirror BP filter Fluorochromes

Red

637 nm

A 750 780/60 AP-Cy7,
BD Horizon™ APC-H7

B 690 710/50 BD Horizon™ APC-R700, Alexa
Fluor™ 700

C 655 670/30 APC, Alexa Fluor™ 647

More information
l About configurations (page 102)
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Small Particle Detector
This chapter covers the following topics:
l Overview (page 108)
l SPD components (page 108)
l Preparing the system for small particle detection (page 109)
l Confirming small particle detection (page 111)
l Aligning the small particle detector (page 115)
l Small particle detector troubleshooting (page 118)
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Overview
The BD® Small Particle Detector (SPD) is a side-scatter detector optimized to enhance resolution of small
particles such as extracellular vesicles. This device can be included as an option on a new or existing system.

Note: The SPD is a separate device installed inside the BD FACSymphony™ A1 flow cytometer, and the output is
captured on the blue laser detector array. For more information, see the blue laser configuration map in Base
configuration polygon maps (page 103). For small particle analysis, low background noise level is critical. The
system must have a low event rate to ensure that the target cells are separated from noise.

SPD components

Item Description

1 Beam splitter

2 Unredirected laser beam

3 Redirected laser beam

4 Pinhole

5 Bandpass filter

6 Small particle PMT with integrated preamplifier

Beam splitter
The 488 90/10 nm beam splitter directs 90% of the 488 nm scattered light towards the pinhole.
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Unredirected laser beam
The straight-line path of the laser beam is from the flow cell to the fiber optics.

Redirected laser beam
The portion of the laser beam being redirected by the beam splitter through the pinhole and bandpass filter to
the SPD.

Pinhole
A 200 µm pinhole, which focuses on the 488 nm laser intercept and blocks stray light and the other laser
intercepts.

Bandpass filter
The 488/10 bandpass filter blocks non-SSC wavelengths from the PMT.

Small particle PMT with integrated preamplifier
Detects 488 nm scattered light and converts it into a digital signal for acquisition by the card-cage.

Preparing the system for small particle detection

Required materials
The following list specifies the materials needed to perform all the procedures described in this chapter.
l BioCytex™ Megamix-Plus SSC Beads (BioCytex reference: 7803)
l 1.5% dilution of BD® Detergent Solution Concentrate

Note: The BD® Detergent Solution Concentrate must be diluted before use. Mix one full 15 mL bottle of
BD® Detergent Solution Concentrate into 985 mL of DI water to make 1 L total.

l Filtered DI water
l Filtered diluent (0.2 µm-filtered 1X PBS)
l BD® CS&T Beads
l BD FACSFlow™ sheath fluid (do not use sheath fluid with surfacant)
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Best practices
The following best practices apply to all the procedures described in this chapter:

l Ensure that system flush is performed no more than 2 weeks before using the SPD. See Flushing the system
(page 42).

l If possible, sheath tanks should be filled the day before running a small particle experiment to allow
settlement of microbubbles.

l Ensure diluents and buffers that are run on the system are filtered and are made fresh every day.

l Ensure that test tubes are clean. Capped tubes are recommended because uncapped tubes can have sub-
micron plastic contamination. If uncapped tubes must be used, rinse the tubes out several times with filtered
diluent.

l Wipe the SIP when changing tubes.

l If high background noise is noticed when running samples, clean the fluidics between samples. See
Managing background noise (page 114).

l Once starting a small particle experiment, keep the instrument in RUN and do not switch back to STANDBY
or PRIME or leave tube support arm to the side for more than 10 seconds as this will cause fluctuations in
background noise levels. It is better to always leave the instrument in RUN and on LOW after starting a small
particle experiment, even when waiting between samples.

Daily preparation before small particle experiments
1. Ensure the sheath tank is full and the waste tank is empty.
2. Turn on the cytometer and computer.

3. Allow the system to stabilize for 30 minutes before proceeding to run a sample (bead or biological). During
this time, steps 4 and 5 can be completed.

4. Bleed the sheath filter and sheath line of air bubbles:

a. For the filter, activate the quick disconnect on the bleed line at the top of the filter to release a few
milliliters of fluid. If air bubbles are still present, repeat the procedure while lightly tapping on the filter to
release the bubbles.

b. For the sheath line from the filter to the instrument, place a beaker under the extension line and
open/close the roller clamp until several milliliters of sheath are removed.

For illustrated details, see Removing air bubbles (page 31).

5. Install a tube with 3 mL of filtered diluent on the SIP. Press RUN and LOW on the cytometer fluidic control
panel for the remainder of the system stabilization time.

6. Ensure that the cytometer configuration windows extension is set to 4. Refer to the BD Cytometer Setup and
Tracking Application Guide for details.

7. Install a tube of BD® CS&T Beads, run a performance check, and verify that it passes. For details, see
Running a performance check (page 57).

8. Change the tubes on the SIP:

a. While still running on LOW, remove the BD® CS&T Beads.

b. Wipe the SIP with a delicate task wipe.
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c. Move the tube support arm to the side for 10 seconds.

d. Place a tube containing 3 mL of filtered diluent on the SIP.

To avoid adverse fluctuations in background event rate, ensure that the tube support arm is to
the side for no longer than 15 seconds.

e. Place the tube support arm under the new tube.

9. Run tube on LOW for 30 seconds to 1 minute and check that the event rate has stabilized.

Confirming small particle detection
This topic covers setting up the SPD QC experiment, setting up PMT voltages for small particles, and managing
the background event rate.

Note: For future experiments, you can use the SPD QC experiment as an experiment template. Also, after
setting up the PMT voltages, you can save the cytometer settings for use as application settings.

Setting up the SPD QC experiment
1. In the BD FACSDiva™software, create a new experiment and add a specimen.
2. Add two tubes to the specimen.
3. Rename the first tube toMegaMix beads and rename the second tube to Diluent background.
4. Set the current tube pointer to the MegaMix beads.
5. In the Cytometer window, click the Parameter tab and delete all parameters except FSC, SSC, SP SSC, and

BB515.
6. Ensure Height and Log are selected for the parameters.
7. In the Threshold tab, select parameter BB515 and set the threshold value to 200.
8. In the Laser tab, verify that the window extension is set to 4.
9. Create the following plots in a global worksheet:

a. SP SSC-H histogram
b. BB515-H vs SP SSC-H dot plot

10. Select all the plots.
11. Using the Plot tab in the Inspector window, enable both X Axis and Y Axis checkboxes on the Biexponential

Display panel.
12. Right-click any plot and select Show Population Hierarchy.
13. Create a 200 nm bead gate on the BB515-H vs SP SSC-H dot plot.
14. Create a statistics view and enable the SP SSC-H median for 200 nm Beads population:

a. Right-click any plot and select Create Statistics View.
b. Right-click the Statistics view and select Edit Statistics View.
c. In the Populations tab, select the 200 nm Beads population.
d. In the Statistics tab, select theMedian checkbox for the SP SSC-H parameter.

e. Click OK.
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Setting up PMT voltages for small particles
This topic assumes that you have created an SPD QC experiment as detailed in the preceding topic.

Note: Cytometer settings used for the following procedure are for SPD alignment.
1. If the SPD QC experiment created using the previous procedure has been closed, reopen it.
2. Vortex a Megamix-Plus SSC beads vial and add 500 µL of the bead solution to a clean BD FACS™ tube.
3. Install the Megamix tube and acquire the sample on LOW.
4. Adjust the voltage for BB515 parameter to display bead populations in the middle of the SP SSC-H vs

BB515-H dot plot.
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5. Align detector as described in Aligning the small particle detector (page 115).
6. Adjust the voltage for the SP SSC parameter until the median of 200 nm bead population is at channel 105.

The bead peak at 500 nm will be off-scale and the bead peak at 240 nm will be either off-scale or close to it.
Position the 200 nm bead gate to fully encompass the 200 nm population.

7. Record the MegaMix-Plus beads mixture.
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Managing background noise

Reducing background noise

The procedure in this topic should be performed at least once after the previous setup procedures, to remove
traces of the MegaMix-Plus beads before checking the background noise. The following procedure assumes that
the system is currently running on LOW with a tube of MegaMix-Plus mixture or filtered diluent on the SIP.

1. Prepare a tube with 3 mL of a 1.5% dilution of BD® Detergent Solution Concentrate. See Required materials
(page 109).

Never mix BD® Detergent Solution Concentrate and bleach because they create chlorine gas.

2. Change the tubes on the SIP:
a. While still running the system on LOW, remove the tube containing MegaMix-Plus beads or filtered

diluent.

b. Wipe the SIP with a delicate task wipe.

c. Move the tube support arm to the side for 10 seconds.
d. Install the tube containing detergent solution on the SIP.

To avoid adverse fluctuations in background event rate, ensure that the tube support arm is to
the side for no longer than 15 seconds.

e. Place the tube support arm under the new tube.
3. Continue to run the detergent solution on LOW for 15 minutes. During this time, prepare a clean tube

containing 3 mL of filtered diluent—see Required materials (page 109).

4. Change the tubes on the SIP:
a. While still running the system on LOW, remove the tube containing detergent solution.

b. Wipe the SIP with a delicate task wipe.

c. Move the tube support arm to the side for 10 seconds.

d. Place a tube containing 3 mL of filtered diluent on the SIP.

To avoid adverse fluctuations in background event rate, ensure that the tube support arm is to
the side for no longer than 15 seconds.

e. Place the tube support arm under the new tube.
5. Continue to run the filtered diluent for 1 minute on LOW.

Analyzing background noise

To confirm that the background noise has stabilized, the following procedure should be performed after the
previous noise-reduction procedure. In other words, the SPD QC experiment is open, a tube of filtered diluent is
loaded on the SIP, and the system is running on LOW.

1. Move the pointer to a new tube with no data recorded.
2. In the Cytometer window, select the Threshold tab.
3. Change the parameter to SP SSC and set the threshold value to 200.
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4. Acquire and observe the threshold rate for 5 minutes.
a. If the event rate stops decreasing, record 1 minute of data for the filtered diluent on LOW.
b. If the event rate does not decrease, see Small particle detector troubleshooting (page 118).

Aligning the small particle detector
The New Focus Picomotor application can be used to align the SPD if needed.

To use the New Focus Picomotor Application:

1. Open the New Focus Picomotor Application by double-clicking the icon on the desktop.

2. In the Controller area in the upper left of the dialog, select the Controller, as shown in the following screen
capture.

3. In the Motor area, you can select the motors that are configured for your system. Typically, Motor 1 is for
the X direction and Motor 2 is for the Y direction.

4. The Position Status shows the relative position of the motors. Zero the positions so you have a reference
established for the starting point. If you cannot hear Motors 1 and 2 responding, return to the preceding
step and select Motors 3 and 4.

5. Select Relative mode and set the steps value to 1000, as highlighted in the following screen capture.
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6. In the Relative steps area, you can select – (minus) or + (plus) to move the motor stage in small increments.

7. While acquiring your MegaMix-Plus bead mixture and examining the SP SSC-H v BB515-H plot and SP-SSC-H
histogram, move the motors one step at a time. The SPD is aligned when the bead peaks are tight and well
separated.

The following plot diagrams and statistics views show an example of a poorly aligned SPD:
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The following plot diagrams and statistics views represent an example after alignment using Picomotor
Application:

8. After alignment, close the New Focus Picomotor Application and return to Setting up PMT voltages for small
particles (page 112).
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Small particle detector troubleshooting

Event rate or background noise is higher than expected

Possible causes Recommended solutions

Your sample diluent may be
the source of the noise or
there may be leftover beads
in the system.

1. Acquire filtered diluent on LOW and observe event rate for 5 minutes. If event rate is
decreasing, continue to run until desired rate is achieved or rate stops falling.

2. Repeat the noise-reduction procedure—see Reducing background noise (page 114).

3. Prepare a clean new tube of filtered diluent.

4. While still running on LOW, remove the tube of filtered diluent used in step 1.

5. Wipe the SIP with a delicate task wipe.

6. Move the tube support arm to the side for 10 seconds.

7. Place the new tube of filtered diluent on the SIP.

To avoid adverse fluctuations in background event rate, ensure that the
tube support arm is to the side for no longer than 15 seconds.

8. Place the tube support arm under the new tube of filtered diluent and continue to run
on LOW.

STANDBY or PRIME mode is initiated in the middle of the small particle
experiment

Possible causes Recommended solutions

Tube support arm is left to
the side for longer than 15
seconds

1. Acquire filtered diluent on LOW and observe event rate for at least 2 minutes.

2. Check the background event rate.

3. Continue running filtered diluent until the event rate stops decreasing.
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11
11

Supplies and consumables
This chapter covers the following topics:
l Ordering information (page 120)
l Beads (page 120)
l Reagents (page 120)
l Equipment (page 121)
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Ordering information
To order spare parts and consumables from BD Biosciences:
l Within the US, call (877) 232-8995.
l Outside the US, contact your local BD Biosciences customer support representative.

Worldwide contact information can be found at bdbiosciences.com.

Beads

Introduction
This topic lists the QC and CS&T beads available.

QC particles

Particle Laser Supplier Catalog
No.

SPHERO™ Rainbow Calibration Particles (8 peaks) Blue, Violet, Yellow-Green and
Red

BD Biosciences 559123

SPHERO Ultra Rainbow Fluorescent Particles (single
peak)

Blue, Violet, Yellow-Green and
Red

Spherotech, Inc. URFP-30-2

BD DNA QC Particles Blue (488 nm) BD Biosciences 349523

CS&T beads

Bead Laser Supplier Catalog No.

BD FACSDiva™ 2.0 CS&T research beads l Violet (405 nm)
l Blue (488 nm)
l Red (637 nm)
l Yellow-green (561 nm)

BD Biosciences l 655050 (50 tests)
l 655051 (150 tests)

Reagents
Reagent Supplier Catalog No.

MegaMix-Plus SSC Beads BioCytex™ 7803

BD FACSFlow™ sheath fluid BD Biosciences 342003

BD FACS™ Sheath Solution with
Surfactant (recommended for use
with the HTS option)

BD Biosciences 336524 (USA),

336911 (Europe)

Monoclonal antibodies BD Biosciences See the BD Biosciences Product
Catalog or the BD Biosciences
website (bdbiosciences.com)
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Reagent Supplier Catalog No.

BD FACS™ Lysing Solution BD Biosciences 349202

BD® Detergent Solution
Concentrate

BD Biosciences 660585

BD FACSClean™ solution BD Biosciences 340345

Dyes and fluorochromes BD Biosciences, Sigma, or Life Technologies –

Chlorine bleach
(5% sodium hypochlorite)

Clorox® or other major supplier (to ensure that
the bleach is at the correct concentration and
free of particulate matter)

–

Equipment
Equipment item Supplier Catalog No.

Bal seal BD Biosciences 343509

O-ring, sample tube 343615

Sheath filter assembly 345743

Falcon polystyrene test tubes, 12 x 75-mm Corning
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4

405-nm violet laser 103
488-nm blue laser 104

5

571-nm yellow-green laser 105

6

637-nm red laser 106

A

acridine orange (AO) 41
air bubbles, removing 31
alarm

waste container 23
Alexa Fluor 104, 106
analysis

data 70
reusing 77
saving 77

antibodies 81
AO See acridine orange 41
application settings

applying 71
creating 65

aspiration (sample), rapid 92
assistance, technical 11

B

Bal seal
ordering 121
replacing 48

bandpass (BP) filters
detector array placement 24
theory 84

BD FACSClean 40, 43

BD FACSClean solution 121
BD FACSDiva software See software 10
BD FACSFlow sheath fluid 120
BD FACSFlow solution 30
BD FACSFlow supply system 28, 42
BD FACSymphony A1

configurations 103
documentation 10
flow cytometer overview 14
lasers and optics 24

BD High Throughput Sampler (HTS) 14, 18, 22, 92
BD Horizon fluorochromes 103
blank optical holders 37
bleach 40, 121
BP See bandpass filters 24
bubbles, removing air 31
buttons

fluid control 18
sample flow rate control 19

C

calculating compensation 68
capacity, waste container 23
cleaning solutions 40
compensation

calculating 68
control tubes 66
recording settings 67
theory 85

components
sheath container shown 29
sheath filter shown 46
waste container shown 33

computer system, about 25
configuration

BD FACSDiva 55
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containers
sheath 23, 29
waste 23, 32, 34

control panel, cytometer 17
controls

fluidics 17
single-stained 55, 70

conventions
safety symbols 10

creating
analysis objects 73
global worksheets 70
statistics view 73

CS&T beads 120
CV, troubleshooting 96
cytometer 15

configuration 37, 55
disconnect error 97
setup 54
starting 28
troubleshooting 92

D

Daily cleaning 41
DAPI, cleaning after using 41
data

analyzing 70, 73
gating 73
recording 70-71

debris, excessive 96
detector arrays 24
detectors 25
dichroic mirrors

theory 84
digital data 15
digital electronics 88
Diva software See software 10
DNA, flow rate for analysis 80
droplet containment system 23
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E

electronics
digital 88
laser controls 88
pulse 86
pulse measurements 87
threshold 88
troubleshooting 97

emission duration 86
event rate

erratic 95
high 94
low 95
zero 93-94

excessive debris 96
excitation wavelength 81
experiments

creating 60
immunophenotyping 70
sample optimization 60
specifying parameters 60

F

FACSClean 40, 43, 121
FACSFlow sheath fluid 120
FACSFlow solution 30
Falcon tubes 92
filters, optical

bandpass (BP) 24, 84
dichroic See dichroic mirrors 84
longpass (LP) 82-83
notch 82
shortpass (SP) 82-83
theory 82

filters, sheath
attaching new 47
replacing 45

FITC and Stokes shift 81
fixed-alignment lasers 15
flow cell

draining 34
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Index 125

fluidics 80
flow rate control buttons 19
fluid control buttons

PRIME 19
RUN 18
STANDBY 19

fluidics
description 18, 80
flow rate control 19
flushing system 42
preparing 34
removing air bubbles 31
run mode 18
sample injection port (SIP) 22

fluidics controls, cytometer 17
fluidics interconnect 32
fluorescence

defined 81
emission 86

fluorescence signal, none 94
fluorochromes

compensation theory 85
measured 37
role in light emission 81

flushing the system 42
forward scatter (FSC) 81
FSC See forward scatter 81

G

gating data 73
global worksheets

analyzing data 73
creating 70
previewing data 70, 77

H

hazard symbol definitions 10
Help, accessing 10
High Throughput Sampler (HTS) 14, 18, 22, 92
Horizon fluorochromes 103
hydrodynamic focusing 80

I

immunophenotyping
analysis 73
experiment 70
hydrodynamic focusing 80

L

lasers
performance check 57
quality control (QC) particles 120
wavelengths and power 24

longpass (LP) filters
defined 82
theory 83

LP See longpass filters 82

M

maintenance
Bal seal 48
cytometer shutdown 42
replacing waste tank cap 44
sample tube O-ring 50
schedule 40
sheath filter 45
system flush 42

mirrors, dichroic longpass (LP) filter 24

N

notch filters 82

O

O-ring
ordering 121
replacing 50
worn 92

online Help 10
optic holder 37
optics

components 24
configuration 55-56
dichroic mirrors 84
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filters 24, 82
optimization, sample 54
ordering spare parts 120

P

Pacific Blue fluorochrome 103
particles 120
PerCP, Stokes shift 81
performance check 57
photodiode 25
photomultiplier tubes (PMTs) 25
PMT See photomultiplier tubes 25
population hierarchy 73
PRIME, fluid control button 19
priming fluidics system 34
propidium iodide (PI) 41
pulse

definition 86
measurements 87
processors 87

Q

quality control (QC)
particles 120
troubleshooting 96

R

recording
compensation settings 67
compensation tubes 66
data 70-71

removing air bubbles, filter 31
replacing

Bal seal 48
sample tube O-ring 50
sheath filter 45
waste air filter 51
waste tank cap 44

reusing analyses 77
RUN

button orange 94
fluid control button 18
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S

safety symbol definitions 10
safety symbols 10
sample

optimization 54
optimization experiment 60
optimization, single-stained controls 55, 70

sample injection port (SIP)
components 22
hydrodynamic focusing 80
replacing Bal seal 48
replacing sample tube O-ring 50

sample tube
injection 22
not fitting 92
requirements 92

samples, running 71
saving analyses 77
scatter

light 81
parameter distortion 96

setup, cytometer 54
sheath

flow 80
sheath container

components shown 29
defined 23
preparing 30

sheath filter
components shown 46
ordering 121
removing air bubbles 31
replacing 45

sheath fluid 80
BD FACSFlow sheath fluid 120

sheath tank
depressurize 30

shortpass (SP) filters 82-83
side scatter (SSC) 81
signals, amplifying 25
SIP See sample injection port 80
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small particle detector
Picomotor application 115
troubleshooting 118

software
cytometer control 10
version 25

spare parts, ordering 120
spillover 85
SSC See side scatter 81
STANDBY, fluid control button 19
starting cytometer 28
statistics views 73
Stokes shift 81
support, technical 11

T

technical assistance 11
thiazole orange (TO) 41
threshold, defined 88
TO See thiazole orange 41
troubleshooting

cytometer 92
electronics 97
small particle detector 118

tubes
Falcon 92
requirements 92

U

user preferences 56

W

waste air filter
component shown 33

waste container 23
alarm 23
capacity 23
components shown 33
defined 23
emptying 32

workstation, about 25
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Becton, Dickinson and Company
BD Biosciences
155 North McCarthy Boulevard
Milpitas, California 95035 USA

BD Biosciences
European Customer Support
Tel +32.53.720.600
help.biosciences@bd.com

bdbiosciences.com
ResearchApplications@bd.com
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